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Introduction

This manual contains detailed instructions and notes on the operation and use of this machine. For your
safety and benefit, read this manual carefully before using the machine. Keep this manual in a handy
place for quick reference.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Do not copy or print any item for which reproduction is prohibited by law.

Copying or printing the following items is generally prohibited by local law:

bank notes, revenue stamps, bonds, stock certificates, bank drafts, checks, passports, driver's licens-
es.

The preceding list is meant as a guide only and is not inclusive. We assume no responsibility for its
completeness or accuracy. If you have any questions concerning the legality of copying or printing cer-
tain items, consult with your legal advisor.

Warning

Use of controls or adjustment or performance of procedures other than those specified in this manual
might result in hazardous radiation exposure.

Two kinds of size notation are employed in this manual. With this machine refer to the metric version.

Trademarks

Microsoft®, Windows® and Windows NT® are registered trademarks of Microsoft Corporation in the
United States and/or other countries.

Adobe®, PostScript®, Acrobat®, PageMaker® and Adobe Type Manager are registered trademarks of
Adobe Systems Incorporated.

PCL® is a registered trademark of Hewlett-Packard Company.

Apple, AppleTalk, EtherTalk, Macintosh, Mac OS and TrueType are trademarks of Apple Computer,
Inc., registered in the United States and other countries.

Rendezvous is a trademark of Apple Computer, Inc.

IPS-PRINT™ Printer Language Emulation Copyright© 2000, Oak Technology, Inc., All Rights Re-
served.

UNIX is a registered trademark in the United States and other countries, licensed exclusively through
X/Open Company Limited.

The Bluetooth® word mark and logos are owned by the Bluetooth SIG, Inc. and any use of such marks
by Ricoh Company, Ltd. is under license.

NetWare is a registered trademark of Novell, Inc.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights to those marks.

The proper names of the Windows operating systems are as follows:

• The product name of Windows® 95 is Microsoft® Windows® 95

• The product name of Windows® 98 is Microsoft® Windows® 98

• The product name of Windows® Me is Microsoft® Windows®  Millennium Edition (Windows Me)

• The product name of Windows® 2000 are as follows:
Microsoft® Windows® 2000 Professional
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Advanced Server

• The product name of Windows® XP are as follows:
Microsoft® Windows® XP Home Edition
Microsoft® Windows® XP Professional

• The product names of Windows Server™ 2003 are as follows:
Microsoft® Windows Server™ 2003 Standard Edition
Microsoft® Windows Server™ 2003 Enterprise Edition
Microsoft® Windows Server™ 2003 Web Edition

• The product name of Windows NT® 4.0 are as follows:
Microsoft® Windows NT® Workstation 4.0
Microsoft® Windows NT® Server 4.0

Notes

Some illustrations in this manual might be slightly different from the machine.

Certain options might not be available in some countries. For details, please contact your local dealer.



i

TABLE OF CONTENTS

Manuals for This Machine .....................................................................................1

How to Read This Manual .....................................................................................3

1. Getting Started

Control Panel..........................................................................................................5
Display Panel .............................................................................................................6

User Authentication...............................................................................................8
User Code Authentication (Using the Control Panel).................................................8
User Code Authentication (Using a Printer Driver) ....................................................8
Login (Using the Control Panel) .................................................................................8
Logoff (Using the Control Panel)................................................................................9
Login (Using a Printer Driver).....................................................................................9

Connecting the Machine .....................................................................................10
Requirements...........................................................................................................10
Connecting the Machine to the Host Using a USB Cable ........................................10
Connecting the Machine to the Host Using the Parallel Cable

 / IEEE 1394 (SCSI print) Cable.............................................................................11
Connecting to the Ethernet Interface .......................................................................12

Setting Paper on the Bypass Tray......................................................................13
Setting Custom Size Paper ......................................................................................15
Setting Thick Paper or OHP Transparencies ...........................................................16

2. Preparing the Machine

Quick Install..........................................................................................................17

Confirming the Connection Method...................................................................19
Network Connection.................................................................................................19
Local Connection .....................................................................................................22

Using the SmartDeviceMonitor for Client Port..................................................23
Installing SmartDeviceMonitor for Client ..................................................................23
Installing the PCL or RPCS Printer Driver (TCP/IP).................................................24
Installing the PCL or RPCS Printer Driver (IPP) ......................................................26
Changing the Port Settings for SmartDeviceMonitor for Client ................................28

Using the Standard TCP/IP Port .........................................................................30
Installing the PCL or RPCS Printer Driver................................................................30

Using the LPR Port ..............................................................................................32
Installing the PCL or RPCS Printer Driver................................................................32

Using as a Windows Network Printer ................................................................34
Installing the PCL or RPCS Printer Driver................................................................34

Using as a NetWare Print Server / Remote Printer ...........................................36
Form Feed................................................................................................................38
Banner Page ............................................................................................................38
Printing after Resetting the Printer ...........................................................................38

Installing the Printer Driver Using USB .............................................................39
Windows 98 SE / Me - USB .....................................................................................39
Windows 2000 - USB ...............................................................................................41
Windows XP, Windows Server 2003 - USB .............................................................42
Troubleshooting for Using USB................................................................................44



ii

Printing with Parallel Connection.......................................................................45
Installing the PCL or RPCS Printer Driver................................................................45

Installing the Printer Driver Using IEEE 1394 (SCSI print)...............................47
Windows 2000..........................................................................................................47
Windows XP, Windows Server 2003........................................................................50

Printing with Bluetooth Connection...................................................................52
Supported Profiles....................................................................................................52
Printing with Bluetooth Connection ..........................................................................52

If a Message Appears during Installation ..........................................................55

Making Option Settings for the Printer ..............................................................56
Conditions for Bidirectional Communication ............................................................56
If Bidirectional Communication Is Disabled..............................................................58

Installing Font Manager 2000..............................................................................59

Using Adobe PageMaker Version 6.0, 6.5, or 7.0 ..............................................60

3. Setting Up the Printer Driver

PCL - Accessing the Printer Properties.............................................................61
Windows 95 / 98 / Me - Accessing the Printer Properties ........................................61
Windows 2000 - Accessing the Printer Properties ...................................................62
Windows XP, Windows Server 2003 - Accessing the Printer Properties .................64
Windows NT 4.0 - Accessing the Printer Properties ................................................66

RPCS - Accessing the Printer Properties ..........................................................68
Windows 95 / 98 / Me - Accessing the Printer Properties ........................................68
Windows 2000 - Accessing the Printer Properties ...................................................70
Windows XP, Windows Server 2003 - Accessing the Printer Properties .................72
Windows NT 4.0 - Accessing the Printer Properties ................................................74

4. Other Print Operations

Printing a PDF File Directly.................................................................................77
Printing Method ........................................................................................................77

Unauthorized Copy Control ................................................................................78
Using [Data security for copying] .................................................................................78
Using [Mask type:] .....................................................................................................80
Important Notice.......................................................................................................81

Using the Print Job List.......................................................................................82
Selecting the Initial Print Job List .............................................................................82
Displaying a Print Job List........................................................................................83

Sample Print .........................................................................................................86
Printing a Sample Print File......................................................................................86
Deleting Sample Print Files......................................................................................88

Locked Print .........................................................................................................89
Printing a Locked Print File ......................................................................................89
Deleting Locked Print Files ......................................................................................91

Hold Print..............................................................................................................92
Printing a Hold Print File ..........................................................................................92
Deleting Hold Print Files...........................................................................................94

Stored Print ..........................................................................................................95
Printing a Stored Print File .......................................................................................95
Deleting Stored Print Files .......................................................................................97



iii

Printing from List Per User ID.............................................................................98
Printing the Desired Print Job ..................................................................................98
Printing All Print Jobs ...............................................................................................98

Spool Printing ....................................................................................................100

Form Feed...........................................................................................................101
Print Using a Selected Tray ...................................................................................101
Canceling Form Feed.............................................................................................102

Canceling a Print Job ........................................................................................103
Windows - Canceling a Print Job ...........................................................................103

Checking the Error Log.....................................................................................105

Covers.................................................................................................................107

Slip Sheet............................................................................................................111

Chaptering ..........................................................................................................113

User Defined Pages ...........................................................................................115

Collate .................................................................................................................116

Printing with the Finisher..................................................................................118
Staple .....................................................................................................................119

5. Printer Features

Printer Features Menu.......................................................................................123

Adjusting Printer Features................................................................................125

Printer Features Parameters.............................................................................126
List / Test Print .......................................................................................................126
Maintenance...........................................................................................................128
System ...................................................................................................................128
Host Interface.........................................................................................................132
PCL Menu ..............................................................................................................132
PS Menu ................................................................................................................134
PDF Menu ..............................................................................................................134

6. Using the Document Server

Accessing the Document Server......................................................................135

7. The Functions and Settings of the Machine

Mainframe...........................................................................................................137
Functions................................................................................................................137
Interface .................................................................................................................137

List of the Setting Items ....................................................................................138
Web Image Monitor................................................................................................138
telnet ......................................................................................................................140
UNIX.......................................................................................................................141
Settings That Can be Used with PostScript 3 ........................................................142



iv

8. Appendix

Software and Utilities Included on the CD-ROM.............................................143
Printer Drivers for This Printer................................................................................144
SmartDeviceMonitor for Admin ..............................................................................146
SmartDeviceMonitor for Client ...............................................................................147

Troubleshooting.................................................................................................149
Error & Status Messages on the Display Panel .....................................................149
The Machine Does Not Print ..................................................................................151
Other Printing Problems.........................................................................................154

System Settings (Parallel Connection) ............................................................159

Precautions when using Windows Server 2003..............................................160
Precautions When Using the Terminal Server Mode .............................................160

Specifications.....................................................................................................161
Options...................................................................................................................163

INDEX....................................................................................................... 165



1

Manuals for This Machine

The following manuals describe the operational procedures of this machine. For
particular functions, see the relevant parts of the manual.

Note

❒ Manuals provided are specific to machine type.

❒ Adobe Acrobat Reader/Adobe Reader is necessary to view the manuals as a
PDF file.

❒ Two CD-ROMs are provided:

• CD-ROM 1 “Operating Instructions”

• CD-ROM 2 “Scanner Driver and Document Management Utility”

❖ General Settings Guide (PDF file - CD-ROM 1)
Provides an overview of the machine and describes System Settings (such as
Tray Paper Settings), Document Server functions and troubleshooting.
Refer to this manual for Address Book procedures such as registering fax
numbers, e-mail addresses, and user codes.

❖ Security Reference 
This manual is for administrators of this machine. It describes security func-
tions that the administrators can use to protect data from being tampered, or
prevent the machine from unauthorized use. Also refer to this manual for the
procedures for registering administrators, as well as setting user and admin-
istrator authentication.

❖ Network Guide (PDF file - CD-ROM 1)
Provides information about configuring and operating the printer in a net-
work environment or using software. This manual covers all models, and
therefore contains functions and settings that may not be available for your
model.
Images, illustrations, functions, and supported operating systems may differ
from those of your model.

❖ Copy Reference (PDF file - CD-ROM 1)
Describes operations, functions, and troubleshooting for the machine's copier
function.

❖ Facsimile Reference <Basic Features> (PDF file - CD-ROM 1)
Describes operations, functions, and troubleshooting for the machine's fac-
simile function.

❖ Facsimile Reference <Advanced Features> (PDF file - CD-ROM 1)
Describes advanced facsimile functions such as line settings and procedures
for registering IDs.
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❖ Printer Reference (this manual) (PDF file - CD-ROM 1)
Describes system settings, operations, functions, and troubleshooting for the
machine’s printer function.

❖ Scanner Reference (PDF file - CD-ROM 1) 
Describes operations, functions, and troubleshooting for the machine’s scan-
ner function.

❖ Manuals for DeskTopBinder Lite
DeskTopBinder Lite is a utility included on the CD-ROM labeled “Scanner
Driver and Document Management Utility”.

• DeskTopBinder Lite Setup Guide (PDF file - CD-ROM 2) 
Describes installation of, and the operating environment for DeskTop-
Binder Lite in detail. This guide can be displayed from the [Setup] dialog
box when DeskTopBinder Lite is installed.

• DeskTopBinder Introduction Guide (PDF file - CD-ROM 2)
Describes operations of DeskTopBinder Lite and provides an overview of
its functions. This guide is added to the [Start] menu when DeskTopBinder
Lite is installed.

• Auto Document Link Guide (PDF file - CD-ROM 2) 
Describes operations and functions of Auto Document Link installed with
DeskTopBinder Lite. This guide is added to the [Start] menu when Desk-
TopBinder Lite is installed.

❖ Other manuals

• PostScript 3 Supplement (PDF file - CD-ROM 1)

• UNIX Supplement (available from an authorized dealer, or as a PDF file on
our Web site)
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How to Read This Manual

Symbols

In this manual, the following symbols are used:

R WARNING:

This symbol indicates a potentially hazardous situation which, if instructions
are not followed, could result in death or serious injury.

R CAUTION:

This symbol indicates a potentially hazardous situation which, if instructions
are not followed, may result in minor or moderate injury, or damage to proper-
ty.

* The statements above are notes for your safety.

Important

If this instruction is not followed, paper might misfeed, originals might be dam-
aged, or data might be lost. Be sure to read this.

Preparation

This symbol indicates prior knowledge or preparation is required before opera-
tion.

Note

This symbol indicates precautions for operation, or actions to take after mal-op-
eration.

Limitation

This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

Reference

This symbol indicates a reference.

[ ]

Keys and buttons that appear on the computer's display.

Keys that appear on the machine's display panel.

{ }

Keys built into the machine's control panel.

Keys on the computer's keyboard.
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1. Getting Started

Control Panel

1. Indicators

Display errors and machine status.

d: Add Staple indicator

D: Add Toner indicator

B: Load Paper indicator

L: Service Call indicator

M: Open Cover indicator

x: Misfeed indicator

See “Control Panel”, General Settings
Guide.

2. {User Tools/Counter} key

• User Tools
Press to change default settings and
conditions to your requirements.

• Counter
Press to display or print the total
number of copies made.

3. Display panel

Displays operation status, error messag-
es, and function menus. See p.6 “Display
Panel”.

4. {Energy Saver} key

Press to switch to the Energy Saver mode.

Note

❒ This key is ineffective during System
Settings (User Tools) operations.

5. Main power indicator

Lights when the main power switch is
turned on.

Important

❒ Do not turn off the main power
switch while the On indicator is lit
or blinking. Doing so may damage
the hard disk.

6. On indicator

Lights when the operation switch is
turned on.

7. Operation switch

Press to turn the power on (the On indi-
cator goes on). Press again to turn the
power off (the On indicator goes off).

8. {Clear/Stop} key

• Press to cancel the entered data.

• Press to stop printing if the Printer
screen is displayed.

9. {#} key

Press after entering a value.

10. Number keys

Press to enter a value for various settings.

AJO001S
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11. Function keys

Press to switch between the “Copy”,
“Document Server”, “Fax”, “Printer”,
and “Scanner” screens.

The indicator for the selected function
lights.

12. Function staMtus indicators

These show the status of the above func-
tions:

• Green: the function is active.

• Red: the function has been interrupted.

13.m: Data In indicator

The Data In indicator shows the status of
data reception from a computer.

• This indicator blinks when data is be-
ing received.

• This indicator lights when there is
data remaining to be printed.

Display Panel

This section describes configuration using the display panel when the printer
function is selected.

Important

❒ The machine switches to offline when you make settings when the machine
is online. After you complete the setting, the machine switches to online au-
tomatically. 

❒ If you make a setting when the machine is offline, it will stay offline afterward.

❒ The function items displayed serve as selector keys. You can select or specify
an item by pressing it lightly.

❒ When you select or specify an item on the display panel, it becomes highlighted.

❒ Keys dimmed (for example, ) cannot be used.

1. Operational status or messages

Displays current machine status, such as
“Ready”, “Offline”, and “Printing...”. In-
formation about the print job (user ID
and document name) appears in this sec-
tion.

2. [fOnline] / [ Offline]

When you press these keys, the machine
switches between online and offline.

When the machine is online, it can re-
ceive data from the computer.

When the machine is offline, it cannot re-
ceive data from the computer.

AJO002S
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3. [Form Feed]

Press to print all the data left in the ma-
chine's input buffer.

Note

❒ When the machine is online, the status
appears dimly.

❒ This function is not available with the
RPCS printer language.

4. [Job Reset]

Press to cancel the current print job.

If you press it when the machine is offline
and Hex Dump is selected, Hex Dump is
canceled.

5. [Print Jobs]

Press to display print jobs sent from a
computer.

6. [Error Log]

Press to display the error logs of print
jobs that sent from a computer.

7. [Spooling Job List]

Press to display spooled jobs.

8. Paper Tray Status indicators

The paper tray settings appear.

Note

❒ When the power is turned on, the copier display is shown. This is a factory
default. This initial setting can be changed. See “User Tools (System Set-
tings)”, General Settings Guide.
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User Authentication

When user authentication (User Code
Authentication, Basic Authentication,
Windows Authentication, LDAP Au-
thentication, or Integration Server
Authentication) is set, the authentica-
tion screen is displayed. Unless a val-
id user name and password are
entered, operations are not possible
with the machine. Log on to operate
the machine, and log off when you
are finished operations. Be sure to log
off to prevent unauthorized users
from using the machine.

Note

❒ Consult the User Administrator
about your login user name, pass-
word, and user code. For details
about the various types of user au-
thentication, consult the appropri-
ate administrators. 

❒ For user code authentication, enter
a number that is registered in the
Address Book as a login user name
as the user code.

User Code Authentication 
(Using the Control Panel)

When user authentication is set, the
following screen appears.

Enter a user code (eight digit), and
then press [#].

User Code Authentication 
(Using a Printer Driver)

When user authentication is set, spec-
ify the user code in the printer prop-
erties of a printer driver. For details,
see the printer driver Help.

Login (Using the Control 
Panel)

Follow the procedure below to log in
when Basic Authentication, Windows
Authentication, LDAP Authentica-
tion, or Integration Server Authenti-
cation is set.

A Press [Enter] for [Login User Name].

B Enter a login user name, and then
press [OK].

C Press [Enter] for [Login Password].

D Enter a login password, and then
press [OK].

E Press [Login].

When the user is authenticated, the
screen for the function you are us-
ing appears.
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Logoff (Using the Control 
Panel)

Follow the procedure below to log off
when Basic Authentication, Windows
Authentication, LDAP Authentica-
tion, or Integration Server Authenti-
cation is set.

A Press the {User Tools/Counter} key.

B Press [→ Logout].

C Press [Yes].

D Press the {User Tools/Counter} key.

Login (Using a Printer Driver)

When Basic Authentication, Win-
dows Authentication, LDAP Authen-
t icat ion,  or  Integrat ion Server
Authentication is set, make encryp-
tion settings in the printer properties
of a printer driver, and then specify a
login user name and password. For
details, see the printer driver Help.

Note

❒ When logged on using a printer
driver, logging off is not required.
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Connecting the Machine

Reference

For information about connection
using Ethernet and wireless LAN,
see “Confirming the Connection”,
Network Guide.

For information about connection
using Bluetooth, see the manual
that comes with the optional Blue-
tooth interface unit.

Requirements

Before using this machine, make sure
all environmental and electrical re-
quirements are met. Connect the ma-
chine to the host computer using the
parallel cable, network interface unit,
or both.

Make sure all cables, connectors, and
electrical outlets necessary to attach
the machine to the host computer or
network are at hand.

Connecting the Machine to the 
Host Using a USB Cable

You can connect the machine to the
host computer using a USB interface
cable.

This machine does not come with a
USB interface cable. Make sure you
purchase the appropriate cable for the
machine and your computer.

Follow the procedure to connect the
machine to the host computer using a
USB interface cable.

A Connect the USB 2.0 interface ca-
ble to the USB port.

B Connect the other end to the USB
port on the host computer.

Note

❒ The USB 2.0 interface board is
supported by Windows 98 SE /
Me / 2000 / XP, Windows Server
2003, Mac OS X v10.3.3 or higher.

• For Windows 98 SE / Me:
Make sure to install “USB
Printing Support”. If USB 2.0
is used with Windows 98 SE
/ Me, only a speed equal to
that of USB 1.1 is possible.

• For Mac OS:
To use Macintosh, the ma-
chine must be equipped with
the optional PostScript 3
unit. If USB 2.0 is used with
Mac OS X v10.3.3 or higher, a
transfer speed of USB 2.0 is
supported.

AJO003S
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Connecting the Machine to the 
Host Using the Parallel Cable / 
IEEE 1394 (SCSI print) Cable

Connect the machine to the host com-
puter using the optional parallel
board or the optional IEEE 1394 inter-
face board. This machine does not
come with a parallel cable to connect
the machine to the host computer.

The machine's parallel interface is a
standard bidirectional interface. It re-
quires a standard IEEE 1284 compli-
ant 36-pin parallel cable and a parallel
port on the host computer. Make sure
you purchase the appropriate cable
for the machine and your computer.

Note

❒ Do not use a parallel cable that is
longer than 3 meters (10 feet).

❒ Rating voltage of the interface con-
nector: Max. DC 5V

Follow the procedure to connect the
machine to the host computer using a
parallel cable or IEEE 1394 interface
cable.

Important

❒ Before connecting the machine and
a computer using an interface ca-
ble, make sure the machine is not
operating, and then turn off the
main power switches of the ma-
chine and computer.

❒ Be sure to use a specified interface
cable. Other cables may cause ra-
dio interference.

A Turn off the main power switches
of the machine and computer.

Important

❒ Before turning off the main
power switch, see “Turning Off
the Power”, General Settings
Guide.

B Plug the cable into the connector
on the machine’s interface.

❖ Parallel Connection

❖ IEEE 1394 (SCSI print) Connection

C Plug the other end of the cable
into the connector on the compu-
ter’s interface.

D Turn on the machine's main pow-
er switch.

AJO004S
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E Turn on the computer.

Note

❒ When using Windows 95 / 98 /
Me / 2000 / XP and Windows
Server 2003, a printer driver in-
stallation screen might appear
when the computer is turned on.
If this happens, click [Cancel] on
the screen. For more informa-
tion, see p.17 “Preparing the
Machine”.

The machine and computer are
now connected. The printer driver
must be installed next. For infor-
mation about how to install the
printer driver, see p.17 “Preparing
the Machine”.

Connecting to the Ethernet 
Interface

The network interface board supports
10 BASE-T or 100 BASE-TX connec-
tions.

Important

❒ Before making the connection, touch
the metallic part to ground yourself.

A A ferrite core for the Ethernet ca-
ble is supplied with this machine.
The Ethernet cable loop should
be about 9 cm (3.5 in.) (A) from
the machine end of the cable.

B Turn off the main power switch.

Important

❒ Make sure the main power is
off. See “Turning On the Pow-
er”, General Settings Guide.

C Connect the Ethernet cable to the
10 BASE-T / 100 BASE-TX port.

D Turn on the main power switch.

1. Indicator (green)

Remains green when the machine is
properly connected to the network.

2. Indicator (yellow)

Turns yellow when 100 BASE-TX is
operating. Turns off when 10 BASE-T
is operating.

AEV047S
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Setting Paper on the Bypass Tray

This section gives instructions for set-
ting paper on the bypass tray. Use the
bypass tray to print onto OHP trans-
parencies, labels, thick paper, and en-
velopes that cannot be loaded in the
paper tray.

Reference

For details about setting paper in
the regular paper tray, see General
Settings Guide.

Note

❒ When loading letterhead paper,
pay attention to its orientation. See
“Orientation-fixed Paper or Two-
Sided Paper”, General Settings
Guide.

❒ Paper within the following dimen-
sions can be set in the bypass tray: 

• Vertical: 90 - 297 mm
 (3.5 - 11.7 in.)

• Horizontal: 148 - 600 mm 
(5.9 - 23.6 in.)

❒ Be sure to set the paper with the
side you want to print facing down
in the bypass tray.

❒ When loading OHP transparencies
or thick paper in the bypass tray,
make the paper setting using the
control panel or printer driver. 

❒ The number of sheets that can be
loaded in the bypass tray depends
on the paper type.

❒ Paper sizes fed from the bypass
tray are output first sheet down,
print side-up.

Limitation

❒ The following functions are disa-
bled when printing from the by-
pass tray: 

• Duplex printing (when the op-
tional unit is installed)

• Auto Tray Select

• Auto Tray Switching

• Rotating collate

• Staple (when the optional unit is
installed)

Important

❒ When printing using the printer
function, original images are al-
ways rotated by 180 degrees (the
orientation of images to be printed
is opposite to that of the copier
function). When printing onto pa-
per with specific orientation re-
quirements, such as envelopes and
letterheads, make sure to rotate the
paper feed orientation to 180 de-
grees.

❒ Be sure to set the paper size using
the printer driver when printing
data from the computer. The paper
size set using the printer driver has
priority over the one set using the
display panel.

A Open the bypass tray.

AJO007S
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B Adjust the paper guides to the pa-
per size.

Important

❒ If the paper guides are not flush
against the paper, skewing and
misfeeds might occur.

1. Extender

2. Paper guides

3. Paper guide release lever

Note

❒ Before loading paper, unlock
the paper guides by pushing up
the paper guide release lever.

❒ To lock the paper guides, push
down the paper guide release
lever. The machine then selects
the bypass tray automatically.

C Gently insert paper face up into
the bypass tray until the beeper
sounds.

Note

❒ The beeper will not sound if it is
turned off. Gently insert paper
until it stops.

❒ Do not stack paper over the lim-
it mark, otherwise a skewed im-
age or misfeeds might occur.

❒ Open out the extender to support
paper sizes larger than A4 L,
81/2 ×11 L.

❒ Fan the paper to get air between
the sheets to avoid a multi-sheet
feed.

❒ When setting an OHP transpar-
ency, make sure that its front
and back sides are properly po-
sitioned.

❒ Select paper type when printing
onto OHP transparencies or
thick paper (over 127.9 g/m2).
For details, see p.16 “Setting
Thick Paper or OHP Transpar-
encies”.

D Select the paper size.

Note

❒ The following procedures are
not required if you select [Driver
/ Command] from [Bypass Tray
Setting Priority] in [System] of
[Printer Features] (see p.128 “Sys-
tem”). In that case, set paper
size using the printer driver.

❒ If you select [Machine Settings]
from [Bypass Tray Setting Priority]
in [System] of [Printer Features]
(see p.128 “System”), the set-
tings made using the control
panel have priority over the
printer driver settings.

❒ If the printer driver is not used,
select [Machine Settings] from
[Bypass Tray Setting Priority] in
[System] of [Printer Features] (see
p.128 “System”). Set the paper
size using the control panel.

❒ Thick paper and OHP transpar-
encies are delivered face up on
the top of the preceding page;
therefore, the prints need to be
rearranged into the correct or-
der. To avoid this, select [Re-
verse order print:] in the RPCS
printer driver settings to deliver
the prints in the correct page or-
der.

AJO008S



Setting Paper on the Bypass Tray

15

1

Reference

For printer driver settings, see
the printer driver Help.

For details about setting custom
sizes, see p.15 “Setting Custom
Size Paper”.

A Press the {User Tools/Counter}
key on the control panel.

B Press [System Settings].

C Press the [Tray Paper Settings]
tab.

D Press [TNext] to scroll through
the list.

E Press [Printer Bypass Paper Size].

F Select the paper size.

Note

❒ Press [UPrevious] or [TNext]
to scroll through the list.

❒ When loading thick paper or
OHP transparencies, select
paper size and paper type.
For details, see p.16 “Setting
Thick Paper or OHP Trans-
parencies”.

G Press [OK].

H Press the {User Tools/Counter}
key.

Setting Custom Size Paper

Note

❒ The following procedures are not
required if you select [Driver / Com-
mand] from [Bypass Tray Setting Pri-
ority] in [System] of [Printer Features]
(see p.128 “System”). In that case,
set the paper size using the printer
driver.

❒ If you select [Machine Settings] from
[Bypass Tray Setting Priority] in [Sys-
tem] of [Printer Features] (see p.128
“System”), the settings made using
the control panel have priority
over the printer driver settings.

❒ If the printer driver is not used, se-
lect [Machine Settings] from [Bypass
Tray Setting Priority] in [System] of
[Printer Features] (see p.128 “Sys-
tem”). Set the paper size using the
control panel.

Reference

For printer driver settings, see the
printer driver Help.

A Press the {User Tools/Counter} key
on the control panel.

B Press [System Settings].

C Press the [Tray Paper Settings] tab.

D Press [TNext] to scroll through the
list.

E Press [Printer Bypass Paper Size].

F Press [Custom size].

If a custom size is already set, press
[Change Size].

G Press [Vertical].
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H Enter the vertical size of the paper
using the number keys, and then
press [#].

I Press [Horizontal].

J Enter the horizontal size of the
paper using the number keys, and
then press [#].

K Press [OK].

The paper sizes entered are dis-
played.

L Press [OK].

M Press the {User Tools/Counter} key.

Setting Thick Paper or OHP 
Transparencies

Note

❒ Insert OHP transparencies in the
K orientation.

❒ The following procedures are not
required if you select [Driver / Com-
mand] from [Bypass Tray Setting Pri-
ority] in [System] of [Printer Features]
(see p.128 “System”). In that case,
set the paper size using the printer
driver.

❒ If you select [Machine Settings] from
[Bypass Tray Setting Priority] in [Sys-
tem] of [Printer Features] (see p.128
“System”), the settings made using
the control panel have priority
over the printer driver settings.

❒ If the printer driver is not used, se-
lect [Machine Settings] from [Bypass
Tray Setting Priority] in [System] of
[Printer Features] (see p.128 “Sys-
tem”). Set the paper size using the
control panel.

Reference

For printer driver settings, see
Printer Driver Help.

A Press the {User Tools/Counter} key
on the control panel.

B Press [System Settings].

C Press the [Tray Paper Settings] tab.

D Press [TNext] to scroll through the
list.

E Press [Paper Type: Bypass Tray].

F Select [OHP] or [Thick Paper].

G Press [OK].

The paper type selected is dis-
played.

H Press the {User Tools/Counter} key.

Note

❒ The settings made will remain
valid until they are reset again.
After printing on OHP trans-
parencies or thick paper, make
sure to clear settings for the next
user.



17

2. Preparing the Machine

Quick Install

Windows 95 / 98 / Me / 2000 / XP, Windows Server 2003, and Windows NT 4.0
users can easily install this software using the CD-ROM provided.

Using Quick Install, the PCL printer driver and/or RPCS printer driver and
SmartDeviceMonitor for Client is installed under network environment, and
TCP/IP port will be set.

Important

❒ To install printer driver under Windows 2000 / XP Professional, Windows
Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrator.

❒ If you connect using USB, refer to p.39 “Installing the Printer Driver Using
USB” and install the printer driver.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts. 

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

D Click [Quick Install].

The software license agreement appears in the [License Agreement] dialog box.

E After reading the agreement, click [I accept the agreement], and then click
[Next >].

F Select the machine model you want to use in the [Select Printer] dialog box.

For network connection via TCP/IP, select the machine whose IP address is
displayed in [Connect To].

For parallel connection, select the machine whose printer port is displayed in
[Connect To].

G Click [Install].

The printer driver installation starts. 

H Click [Finish].

A message about restarting the computer may appear. Restart the computer
to complete installation.
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I Click [Exit] in the first dialog box of the installer, and then take out the CD-
ROM.

Note

❒ To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

❒ Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

❒ Select a machine to whose IP address is displayed in [Connect To] to install
SmartDeviceMonitor for Client when using TCP/IP.

Reference

Quick Install is not available unless bidirectional communication between
the machine and computer is enabled via parallel connection. See p.58 “If
Bidirectional Communication Is Disabled” for details about bidirectional
communication between the machine and computer.
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Confirming the Connection Method

This machine supports network and local connection.

Before installing the printer driver, check how the machine is connected. Follow
the driver installation procedure that is appropriate to the connection method.

Network Connection

This machine can be used as a Windows printing port or network printer.

Using This Machine as the Windows Printing port

Network connections can be established through Ethernet, IEEE 802.11b, and
IEEE 1394 (IP over 1394).

Available ports are determined based on the combination of Windows operating
system version and connection method used.

❖ Windows 95 / 98

❖ Windows Me

Connection Method Available Ports

Ethernet / IEEE 802.11b SmartDeviceMonitor for Client port

IEEE 1394 (IP over 1394) None

Connection Method Available Ports

Ethernet / IEEE 802.11b SmartDeviceMonitor for Client port

IEEE 1394 (IP over 1394) SmartDeviceMonitor for Client port
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❖ Windows 2000

❖ Windows XP

❖ Windows Server 2003

❖ Windows NT 4.0

Reference

See the explanation of how to install the printer driver for each type of port.
For the SmartDeviceMonitor for Client port, see p.23 “Using the SmartDe-
viceMonitor for Client Port”.

For the Standard TCP/IP port, see p.30 “Using the Standard TCP/IP Port”.

For the LPR port, see p.32 “Using the LPR Port”.

Connection Method Available Ports

Ethernet / IEEE 802.11b SmartDeviceMonitor for Client port

Standard TCP/IP

LPR port

IEEE 1394 (IP over 1394) None

Connection Method Available Ports

Ethernet / IEEE 802.11b SmartDeviceMonitor for Client port

Standard TCP/IP

LPR port

IEEE 1394 (IP over 1394) SmartDeviceMonitor for Client port

Standard TCP/IP

Connection Method Available Ports

Ethernet / IEEE 802.11b SmartDeviceMonitor for Client port

Standard TCP/IP

LPR port

IEEE 1394 (IP over 1394) SmartDeviceMonitor for Client port

Standard TCP/IP

Connection Method Available Ports

Ethernet / IEEE 802.11b SmartDeviceMonitor for Client port

LPR port

IEEE 1394 (IP over 1394) None
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Using as a network printer

This machine can be used as the Windows network printer, the NetWare print
server, or the NetWare remote printer.

Reference

See the explanation of how to install the printer driver for each type of net-
work printer. 

For the Windows network printer, see p.34 “Using as a Windows Network
Printer”.

For the NetWare print server and remote printer, see p.36 “Using as a Net-
Ware Print Server / Remote Printer”.
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Local Connection

Local connections can be established via parallel, USB, IEEE 1394 (SCSI print),
and Bluetooth connections.

Windows operating system version determines the available connection methods.

• Windows 95:

• Parallel connections

• Windows 98: 

• Parallel connections

• Windows 98 SE / Me:

• USB and Parallel connections

• Windows 2000:

• USB, Parallel, IEEE 1394 (SCSI print), and Bluetooth connections

• Windows XP:

• USB, Parallel, IEEE 1394 (SCSI print), and Bluetooth connections

• Windows Server 2003:

• USB, Parallel, IEEE 1394 (SCSI print), and Bluetooth connections

• Windows NT 4.0:

• Parallel connections

Reference

See the explanation of how to install the printer driver for each method of
connection. 

For the USB connection, see p.39 “Installing the Printer Driver Using USB”.

For the parallel connection, see p.45 “Printing with Parallel Connection”.

For the IEEE 1394 (SCSI print) connection, see p.47 “Installing the Printer
Driver Using IEEE 1394 (SCSI print)”.

For the Bluetooth connection, see p.52 “Printing with Bluetooth Connec-
tion”.
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Using the SmartDeviceMonitor for Client 
Port

Installing SmartDeviceMonitor for Client

Important

❒ To install SmartDeviceMonitor for Client under Windows 2000 / XP Profes-
sional, Windows Server 2003, and Windows NT 4.0, you must have an ac-
count that has Manage Printers permission. Log on as an Administrator.

❒ Install SmartDeviceMonitor for Client before installing the printer driver
when using the SmartDeviceMonitor for Client port.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

D Click [SmartDeviceMonitor for Client/Admin].

E The SmartDeviceMonitor for Client installer starts.

F The software license agreement appears in the [License Agreement] dialog
box. After reading through its contents, click [I accept the agreement.], and
then click [Next >].

G Click [SmartDeviceMonitor for Client], and then click [Next >].

The SmartDeviceMonitor for Client installer starts.

H Follow the instructions on the display to install SmartDeviceMonitor for
Client. 

I Click [Finish].

If you are required to restart the computer after installing SmartDeviceMon-
itor for Client, restart the computer.

Note

❒ To stop installation of the selected software, click [Cancel] before installa-
tion is complete.



Preparing the Machine

24

2

Installing the PCL or RPCS Printer Driver (TCP/IP)

Important

❒ To install this printer driver under Windows 2000 / XP Professional, Win-
dows Server 2003, and Windows NT 4.0, you must have an account that has
Manage Printers permission. Log on as an Administrators or Power Users
group member.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

D Click [PCL/RPCS Printer Drivers].

E The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [I accept the agreement.], and then click [Next
>].

F Select the printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

G Click [Next >].

H Select the machine model you want to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

I Double-click the printer name to display the printer settings.

Note

❒ The details shown in [Comment:], [Driver:], and [Port:] vary depending on
the operating system, printer model, and port.

J Click [Port:], and then click [Add].

K Click [SmartDeviceMonitor], and then click [OK].

L Click [TCP/IP], and then click [Search].

A list of printers using TCP/IP appears.
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M Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use
a machine not listed here, click [Specify Address], and then enter the IP address
or host name of the machine.

Under Windows 95 / 98 / Me, you cannot add an IP address partially similar
to the one already used. For example, if “192.168.0.2” is in use, “192.168.0.2xx”
cannot be used. Similarly, if “192.168.0.20” is in use, “192.168.0.2” cannot be
used. 

N Check that the port of the selected printer is displayed in [Port:].

O Set a user code, if necessary. 

This allows a SmartDeviceMonitor for Admin user to display and check sta-
tistics about the number of sheets which each user prints. For details, see
SmartDeviceMonitor for Admin Help. 

Up to 8 numeric characters can be entered. No alphabetic character or symbol
can be entered.

P Select the [Default Printer] check box to configure the printer as default.

Q Click [Continue].

Installation starts.

R Click [Finish] in the installation completion dialog box.

A message about restarting the computer may appear. Restart the computer
to complete installation.

Reference

A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, install use [Add Printer]. See p.55
“If a Message Appears during Installation”.
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Installing the PCL or RPCS Printer Driver (IPP)

Important

❒ To install printer driver under Windows 2000 / XP Professional, Windows
Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. For this, log on as an Administrators or Power Users
group member.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

D Click [PCL/RPCS Printer Drivers].

E The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [I accept the agreement.], and then click [Next
>].

F Select a printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

G Select the machine model you want to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

H Double-click the printer name to display the printer settings.

Note

❒ The details shown in [Comment:], [Driver:], and [Port:] vary depending on
the operating system, printer model, and port.

I Click [Port:], and then click [Add].

J Click [SmartDeviceMonitor], and then click [OK].

K Click [IPP].
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L In the [Printer URL] box, enter “http://printer's address/printer” as the print-
er's address.

If the server authentication is issued, to enable SSL (a protocol for encrypted
communication), enter “https://printer's address/printer” (Internet Explorer
5.01, or a higher version must be installed).

(example IP address: 192.168.15.16)

http://192.168.15.16/printer

https://192.168.15.16/printer

You can enter “http://printer's address/ipp” as the printer's address.

M Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the one of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box be-
comes the IPP port name.

N Click [Detailed Settings] to make necessary settings.

For information about the settings, see SmartDeviceMonitor for Client Help.

O Click [OK].

P Check that the port of the selected printer is displayed in [Port:].

Q Set a user code, if necessary. 

This allows a SmartDeviceMonitor for Admin user to display and check the
number of sheets each user prints. For details, see SmartDeviceMonitor for
Admin Help.

Up to 8 numeric characters can be entered. No alphabetic characters or sym-
bols can be entered.

R Select the [Default Printer] check box to configure the printer as default.

S Click [Continue].

Installation starts.

T Click [Finish] in the installation completion dialog box.

A message about restarting the computer may appear. Restart the computer
to complete installation.

Note

❒ To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

Reference

A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See p.55 “If a
Message Appears during Installation”.
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Changing the Port Settings for SmartDeviceMonitor for Client

Follow the procedure below to change the SmartDeviceMonitor for Client set-
tings, such as TCP/IP timeout, recovery/parallel printing, and printer groups.

Windows 95 / 98:

A Open the [Printers] window from the [Start] menu.

B In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

C Click the [Details] tab, and then click [Port Settings].

The [Port Settings] dialog box appears.

Windows 2000 / Windows NT 4.0:

A Open [Printers] window from [Start] menu.

B In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

C On the [Ports] tab, click [Configure Port].

The [Port Settings] dialog box appears.
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Windows XP, Windows Server 2003: 

A Open the [Printers and Faxes] window from the [Start] menu.

The [Printers and Faxes] window appears.

B Click the icon of the machine you want to use. On the [File] menu, click
[Properties]. The printer properties appear.

C Click the [Ports] tab, and then click [Configure Port].

The [Port Configuration] dialog box appears.

• For TCP/IP, timeout setting can be configured.

Note

❒ If no settings on the [Recovery/Parallel Printing] tab are available, follow
the procedure below.

A Click [Cancel] to close the [Port Configuration:] dialog box.

B Start SmartDeviceMonitor for Client, and then right-click the Smart-
DeviceMonitor for Client icon on the taskbar.

C Click [Extended Features Settings], and then select the [Set Recovery/Par-
allel Printing for each port] check box.

D Click [OK] to close the [Extended Features Settings] dialog box.

• User, proxy, and timeout settings can be configured for IPP.

Reference

For information about these settings, see “Using SmartDeviceMonitor for
Client”, Network Guide, or SmartDeviceMonitor for Client Help.
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Using the Standard TCP/IP Port

Installing the PCL or RPCS Printer Driver

Important

❒ To install this printer driver under Windows 2000 / XP Professional, and
Windows Server 2003, you must have an account that has Manage Printers
permission. Log on as an Administrators or Power Users group member.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

D Click [PCL/RPCS Printer Drivers].

E The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [I accept the agreement.], and then click [Next
>].

F Select a printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

G Click [Next >].

H Select the machine model you want to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

I Double-click the printer name to display the printer settings.

Note

❒ The details shown in [Comment:], [Driver:], and [Port:] vary depending on
the operating system, printer model, and port.

J Click [Port:], and then click [Add].

K Click [Standard TCP/IP Port], and then click [Add].

Configure the Standard TCP/IP port settings, and then see Windows Help if
[Standard TCP/IP Port] does not appear.

L Click [Next >] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.
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M Enter the printer name or IP address in the [Printer Name or IP Address] box.

The [Port Name] text box automatically obtains a port name. Change this name
if necessary.

When the device selection appears, select “RICOH NetworkPrinter Driver C
Model”.

N Click [Next >].

O Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

The installation start dialog box reappears.

P Check that the port of the selected printer is displayed in [Port:].

Q Configure the default printer as necessary.

R Click [Continue].

The printer driver installation starts.

S Click [Finish] in the installation completion dialog box.

A message about restarting the computer may appear. Restart the computer
to complete installation.

Note

❒ To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

Reference

A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See p.55 “If a
Message Appears during Installation”.
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Using the LPR Port

Installing the PCL or RPCS Printer Driver

Important

❒ To install this printer driver under Windows 2000 / XP Professional, Win-
dows Server 2003, and Windows NT 4.0, you must have an account that has
Manage Printers permission. Log on as an Administrators or Power Users
group member.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

D Click [PCL/RPCS Printer Drivers].

E The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [I accept the agreement.], and then click [Next
>].

F Select a printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

G Select the machine model you want to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

H Click [Next >].

I Double-click the printer name to display the printer settings.

Note

❒ The details shown in [Comment:], [Driver:], and [Port:] vary depending on
the operating system, printer model, and port.

J Click [Port:], and then click [Add].

K Click [LPR Port], and then click [Add].

If [LPR Port] does not appear, see Windows Help and install it.

L Enter the printer's IP address in the [Name or address of server providing lpd]
box.
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M Enter “lp” in the [Name of printer or print queue on that server] box, and then click
[OK].

The port is added.

N Check that the port of the selected printer is displayed in [Port:].

O Configure the default printer as necessary.

P Click [Continue].

The printer driver installation starts.

Q Click [Finish] in the installation completion dialog box.

A message about restarting the computer may appear. Restart the computer
to complete installation. 

Reference

A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See p.55 “If a
Message Appears during Installation”.
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Using as a Windows Network Printer

Installing the PCL or RPCS Printer Driver

To use the print server, install the printer driver by selecting “Network printer
server”, and then select the Windows 2000 / XP, Windows Server 2003, or Win-
dows NT 4.0 shared printer.

This section assumes that the client has already been configured to communicate
with a Windows 2000 / XP, Windows Server 2003, or Windows NT 4.0 print
server. Do not begin the following procedure before the client is set up and con-
figured correctly.

Important

❒ To install the printer driver under Windows 2000 / XP Professional, Win-
dows Server 2003, and Windows NT 4.0, you must have an account that has
Manage Printers permission. Log on as an Administrators or Power Users
group member.

❒ If you print with a print server connected to the printer using the SmartDe-
viceMonitor port, Recovery Printing and Parallel Printing cannot be used
from the client.

❒ If you print with a Windows XP or Windows Server 2003 print server, notifi-
cation functions of SmartDeviceMonitor may not be used with the client. 

❒ If you print with a Windows NT 4.0 print server, install the printer driver be-
fore you connect the print server to the printer.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

D Click [PCL/RPCS Printer Drivers].

E The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [I accept the agreement.], and then click [Next >].

F Select the printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

G Click [Next >].
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H Select the [Printer Name] check box to select the printer models you want to
use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

I Double-click the printer name to display the printer settings.

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

J Click [Port:], and then click [Add].

K Click [Network Printer], and then click [OK].

L Double-click the computer name you want to use as a print server in the
[Browse for Printer] window.

M Select the printer you want to use, and then click [OK].

N Check that the port of the selected printer is displayed in [Port:].

O Configure the user code as necessary.

For an RPCS printer driver, a user code can be set after the printer driver in-
stallation. For information about user code, see the printer driver Help.

P Select the [Default Printer] check box to configure the printer as default.

Q Click [Continue].

The printer driver installation starts.

R Click [Finish] in the installation completion dialog box.

A message about restarting the computer may appear. Restart the computer
to complete installation. 

Reference

A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See p.55 “If a
Message Appears during Installation”.
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Using as a NetWare Print Server / Remote 
Printer

This explains how to set up the Windows computer used as the NetWare client.

Important

❒ To install this printer driver under Windows 2000 / XP Professional, Win-
dows Server 2003, and Windows NT 4.0, you must have an account that has
Manage Printers permission. Log on as an Administrators or Power Users
group member.

The following explanation assumes NetWare Client is installed on the client
computer and the NetWare server environment is correctly set up. Install all nec-
essary client applications before following this procedure.

Set up the printer driver while logging on to the NetWare file server.

The following values are used in the example:

• Operating system: Windows 98

• NetWare version: 4.1

• File server name: CAREE

• Queue name: R-QUEUE

A Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

B Select an interface language, and then click [OK].

The default interface language is English.

C Click [PCL/RPCS Printer Drivers].

D The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [I accept the agreement.], and then click [Next
>].

E Select the printer driver you want to use in the [Select Program] dialog box. 

You can select several printer drivers.

F Click [Next >].

G Select the [Printer Name] check box to select the printer model you want to
use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.
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H Double-click the printer name to display the printer settings.

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

I Click [Port:], and then click [Add].

J Click [Network Printer], and then click [OK].

K Double-click the name of the NetWare file server on the network tree.

The created queue is displayed.

L Select the print queue, and then click [OK].

M Check that the port of the selected printer is displayed in [Port:].

N Click [Continue].

The printer driver installation starts.

O Click [Finish] in the [Component selection] dialog box.

P Click [Finish] in the [Introduction complete] dialog box.

Q In the [Printers] window, open the printer properties.

Under Windows XP or Windows Server 2003, open the printer properties
from the [Printers and Faxes] window. 

R On the [Printer Settings] tab, clear the [Form Feed] and [Enable Banner] check
boxes.

Under Windows 2000 / XP, Windows Server 2003, or Windows NT 4.0, click
the [NetWare setting] tab.

Do not select these check boxes since they are automatically selected by the
printer driver. If you select the check boxes, the printer may not print correctly.

S Click [OK] to close the printer properties dialog box.

Note

❒ The protocol is set to inactive as default. Enable it using Web Image Mon-
itor or Telnet.
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Form Feed

Do not use NetWare to configure form feed. Form feed is controlled by the print-
er driver on Windows. If NetWare form feed is configured, the printer may not
print properly. 

Follow the procedure below to disable form feed according to the operating sys-
tem used:

• Under Windows 95 / 98 / Me, clear the [Form feed] check box on the [Printer
Settings] tab in the printer properties dialog box.

• Under Windows 2000 / XP, Windows Server 2003, or Windows NT 4.0, clear
the [Form feed] check box on the [NetWare Settings] tab in the printer properties
dialog box.

Banner Page

Do not use NetWare to configure a banner page. 

Follow the procedure below to disable banner pages according to the operating
system used:

• Under Windows 95 / 98 / Me, clear the [Enable banner] check box on the [Print-
er Settings] tab in the printer properties dialog box.

• Under Windows 2000 / XP, Windows Server 2003, or Windows NT 4.0, clear
the [Enable banner] check box on the [NetWare Settings] tab in the printer prop-
erties dialog box.

Printing after Resetting the Printer

Printer to print server connection requires 30 - 40 seconds to resume after the
printer is reset. During this period, jobs may be accepted (depending on Net-
Ware specifications) but not printed.

To print after resetting the printer as the remote printer, check on the print server
that the remote printer is disconnected, or wait for two minutes before trying to
print.
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Installing the Printer Driver Using USB

This section explains how to install printer drivers using USB.

Before installing, check that only the operating system is running on the compu-
ter and no print jobs are in progress.

The printer drivers can be installed from the supplied CD-ROM provided with
this machine.

Windows 98 SE / Me - USB

Important

❒ Installation via USB is not possible under Windows 95 / 98. Upgrade to Win-
dows 98 SE / Me.

When USB is first used, the plug and play function starts and the [New Hardware
Found], [Device Driver Wizard], or [Add New Hardware Wizard] dialog box appears, de-
pending on the operating system.

If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the “USB” port is added to the [Printers] window.

A Turn off the power of the machine.

B Connect the machine to the computer using the USB cable.

Connect the USB cable firmly.

C Turn on the power of the computer.

D Click [Next >].

E Click [Search for the best driver for your device. {Recommended}.], and then click
[Next >].

F Select the [Specify a location:] check box, and then click [Browse...].

The [Browse for Folder] dialog box appears.

G Insert the CD-ROM into the CD-ROM drive.

Note

❒ When Auto Run starts, click [Exit].

❒ To disable Auto Run, press the {Shift} key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.
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H Specify the location where USB Printing Support is located, and then click
[Next >].

If the CD-ROM drive is D, the source files of USB Printing Support are stored
in the following location:

D:\DRIVERS\USBPRINT\WIN98ME

I Check the location, and then click [Next >].

USB Printing Support is installed.

J Click [Finish].

If the printer driver has already been installed, plug and play is enabled, and
the icon of the printer connected to the “USB001” port is added to the [Printers]
window.

K Click [Next >].

L Click [Search for the best driver for your device. {Recommended}.], and then click
[Next >].

M Select the [Specify a location:] check box, and then click [Browse...].

The [Browse for Folder] dialog box appears.

N Insert the CD-ROM into the CD-ROM drive.

Note

❒ When Auto Run starts, click [Exit].

❒ To disable Auto Run, press the {Shift} key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

O Specify the location where the source files of the printer driver are stored,
and then click [Nex t>].

If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:

• RPCS
D:\DRIVERS\RPCS\WIN9X_ME\(Language)\DISK1

• PCL 5e
D:\DRIVERS\PCL5E\WIN9X_ME\(Language)\DISK1

• PCL 6
D:\DRIVERS\PCL6\WIN9X_ME\(Language)\DISK1

• PostScript 3
D:\DRIVERS\PS3\WIN9X_ME\(Language)\DISK1

P Check the location, and then click [Next >].

Add Printer Wizard starts.
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Q Click [Finish].

Installation is complete. If installation is successful, the icon of the printer
connected to the “USB001” port is added to the [Printers] window.

Note

❒ The number after “USB” varies depending on the number of printers con-
nected.

❒ It is not necessary to reinstall USB Printing Support when connecting a dif-
ferent machine via USB interface when USB Printing Support is installed.

❒ After installing USB Printing Support, if the printer driver is not installed,
follow the plug-and-play instructions of the printer.

Windows 2000 - USB

Important

❒ Installing a printer driver requires Administrator permission. Log on using
an account that has Administrator permission.

When USB is first used, Found New Hardware Wizard starts, and USB Printing
Support is installed automatically.

If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the “USB” port is added to the [Printers] window.

If the printer driver is not installed, follow the plug-and-play instructions of the
printer to install it from the supplied CD-ROM.

A Turn off the power of the machine.

B Connect the machine to the computer using the USB cable.

Connect the USB cable firmly.

C Turn on the power of the computer.

D Click [Next >] in the [Found New Hardware Wizard] dialog box.

E Select the [“Search for a suitable driver for my device (recommended)”] check box,
and then click [Next >].

F Select the [Specify location] check box, and then click [Next >].

G Insert the CD-ROM into the CD-ROM drive.

Note

❒ When Auto Run starts, click [Exit].

❒ To disable Auto Run, press the left {Shift} key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.
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H Specify the location where the source files of the printer driver is stored.

If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:

• RPCS
D:\DRIVERS\RPCS\WIN2K_XP\(Language)\DISK1

• PCL 5e
D:\DRIVERS\PCL5E\WIN2K_XP\(Language)\DISK1

• PCL 6
D:\DRIVERS\PCL6\WIN2K_XP\(Language)\DISK1

• PostScript 3
D:\DRIVERS\PS3\WIN2K_XP\(Language)\DISK1

I Check the printer driver location, and then click [OK].

J Click [Next >].

K Click [Finish].

If the printer driver has already been installed, plug and play is enabled, and
the icon of the printer connected to the “USB001” port is added to the [Printers]
window.

Note

❒ The number after “USB” varies depending on the number of printers con-
nected.

Windows XP, Windows Server 2003 - USB

Important

❒ Installing a printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

When USB is first used, Found New Hardware Wizard starts, and USB Printing
Support is installed automatically.

If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the “USB” port is added to the [Printers] window.

The printer drivers can be installed from the supplied CD-ROM provided with
this machine.

If the printer driver is not installed, follow the plug-and-play instructions of the
printer to install it from the supplied CD-ROM.

A Turn off the power of the machine.

B Connect the machine to the computer using the USB cable.

Connect the USB cable firmly.

C Turn on the power of the computer.
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D In the Found New Hardware Wizard display, click [Search for a suitable driver
for my device [recommended] ], and then click [Next >].

E Insert the CD-ROM into the CD-ROM drive.

Note

❒ If Auto Run starts, click [Cancel], and then [Exit].

❒ To disable Auto Run, press the left {Shift} key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

F Select the [Include this location in the search] check box under [Search for the best driv-
er in these location], and then click [Browse] to select the printer driver location.

If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:

• RPCS
D:\DRIVERS\RPCS\WIN2K_XP\(Language)\DISK1

• PCL 5e
D:\DRIVERS\PCL5E\WIN2K_XP\(Language)\DISK1

• PCL 6
D:\DRIVERS\PCL6\WIN2K_XP\(Language)\DISK1

• PostScript 3
D:\DRIVERS\PS3\WIN2K_XP\(Language)\DISK1

G Check the printer driver location, and then click [Next >].

H Click [Continue].

I Click [Finish].

If installation is successful, the icon of the printer connected to the “USB001”
port is added to the [Printers] window.

Note

❒ The number after “USB” varies depending on the number of printers con-
nected.
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Troubleshooting for Using USB

Problems Solutions

The machine is not automatically recognized. Turn off the power of the machine, reconnect 
the USB cable, and then turn it on again.

Windows has already configured the USB set-
tings.

Open Windows' Device Manager, and then, 
under [Universal Serial Bus controllers], remove 
any conflicting devices. Conflicting devices 
have a yellow [!] or [?] icon by them. Take care 
not to accidentally remove required devices. 
For details, see Windows Help.

Note

❒ When using Windows 2000 / XP or Win-
dows Server 2003, an erroneous device is 
displayed under [USB Controller] in the [De-

vice Manager] dialog box.
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Printing with Parallel Connection

To use a machine connected using a parallel interface, click [LPT1] when install-
ing the printer driver.

Installing the PCL or RPCS Printer Driver

Important

❒ To install this printer driver under Windows 2000 / XP Professional, Win-
dows Server 2003, and Windows NT 4.0, you must have an account that has
Manage Printers permission. Log on as an Administrators or Power Users
group member.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

D Click [PCL/RPCS Printer Drivers].

E The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [I accept the agreement.], and then click [Next
>].

F Select the printer driver you want to use in the [Select Program] dialog box. 

You can select several printer drivers.

G Click [Next >].

H Select the [Printer Name] check box to select the printer model you want to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

I Double-click the printer name to display the printer settings.

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

J Check that [LPT1:] is shown in [Port:].

K Select the [Default Printer] check box to configure the printer as default.
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L Click [Finish].

The printer driver installation starts.

M Click [Finish] in the installation completion dialog box.

Note

❒ To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

Reference

A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See p.55 “If a
Message Appears during Installation”.
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Installing the Printer Driver Using IEEE 1394 
(SCSI print)

The printer drivers can be installed from the supplied CD-ROM provided with
this machine. 

Important

❒ Quit all applications currently running, and do not print during installation.

❒ Do not connect IEEE 1394 or USB devices to the computer or turn on another
printers during installation.

❒ Before uninstalling the printer driver, check that the IEEE 1394 interface cable
is disconnected from the computer.

❒ SCSI print must be set to “active” from the control panel. For details, see Net-
work Guide.

❒ This machine can receive print data from one computer at a time only. An
message may appear if jobs from different computers collide.

❒ If jobs collide, the first received is printed first.

❒ When the printer driver is properly installed, connecting or disconnecting the
optional IEEE 1394 cable causes the printer icon to change.

Windows 2000

Note

❒ If [Found New Hardware Wizard] appears every time the computer is started or
the cable is connected, disable the device. To install another printer driver af-
ter setting the “1394_00n” port, click [1394_00] as a port during the printer
driver installation.

❒ Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

❒ The optional 1394 interface unit can be used only with Service Pack 1 (SP1) or
higher.

A Connect the machine to the computer using the IEEE 1394 interface cable.

B Click [Next >] in the [Found New Hardware Wizard] dialog box.

CWhen the message “This wizard will complete the installation for this De-
vice: Unknown” appears, click [Specify a location], and then click [Next >].

DWhen the message “Locate Driver Files” appears, select the [Optional search
locations.] check box, and then click [Specify a location], and then click [Next >].
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E Insert the CD-ROM into the CD-ROM drive.

Note

❒ If Auto Run starts, click [Cancel], and then [Exit].

❒ To disable Auto Run, press the left {Shift} key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

F Click [Browse].

G Select the printer driver you want to use.

If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:

• RPCS
D:\DRIVERS\RPCS\WIN2K_XP\(Language)\DISK1

• PCL 5e
D:\DRIVERS\PCL5E\WIN2K_XP\(Language)\DISK1

• PCL 6
D:\DRIVERS\PCL6\WIN2K_XP\(Language)\DISK1

• PostScript 3
D:\DRIVERS\PS3\WIN2K_XP\(Language)\DISK1

H Click [Open].

I Click [OK].
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J Follow the on-screen instructions.

When installation is complete, the printer connected to “1394_00n” appears
in the [Printers] window: (“n” shows the number of printers connected.)

Note

❒ If the printer driver has already been installed, the printer icon is added to
the [Printers] window. In this case, printer driver installation is not necessary.

❒ If printing does not work properly after the installation, delete the port and re-
install the printer driver. For details, see p.151 “The Machine Does Not
Print”.

❒ If you do not want to install the printer when Found New Hardware Wiz-
ard starts under an operating system that supports SCSI print, disable the
device by following the procedure below.

A When the [Found New Hardware Wizard] dialog box appears, click [Next >].

B When the message “This wizard will complete the installation for this
Device: Unknown” appears, select the [Search for a suitable driver for my
device recommended] check box, and then click [Next >].

C When the message “Please choose your search and installation option.”
appears, clear all check boxes from [Search for the best driver in these loca-
tions.], and then click [Next >].

D When the message “Driver Files Search Results” appears, select the [Dis-
able the device. The Add/Remove Hardware Wizard in the control Panel can be
able to complete the driver installations.] check box, and then click [Finish].
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Windows XP, Windows Server 2003

Important

❒ SCSI print must be set to “active” from the control panel. For details, see Net-
work Guide.

❒ Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

Note

❒ This machine can receive print data from one computer at a time only. If a job
from a computer collides with other data, a message may appear on the com-
puter.

❒ To install another printer driver after setting the “1394_00n” port, click
[1394_00] as a port during the printer driver installation.

❒ When the printer driver is properly installed, connecting or disconnecting the
optional IEEE 1394 cable causes the printer icon to change.

A Connect the machine to the computer using the IEEE 1394 interface cable.

When the [Found New Hardware Wizard] dialog box appears, check that [This wiz-
ard helps you install software for: (Unknown)] is displayed.

B Select the [Install from a list on specific location (Advanced)] check box, and then
click [Next >].

CWhen the message “Please choose your search and installation option.” ap-
pears, select the [Search for the best driver in these locations.] check box, select
the [Include this location in the search:] check box, and then select the [Include
this location in the search:] check box.

D Insert the CD-ROM into the CD-ROM drive.

Note

❒ If Auto Run starts, click [Cancel], and then [Exit].

❒ To disable Auto Run, press the left {Shift} key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.
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E Specify the location where the source files of the printer driver is stored,
and then click [Next >].

If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:

• RPCS
D:\DRIVERS\RPCS\WIN2K_XP\(Language)\DISK1

• PCL 5e
D:\DRIVERS\PCL5E\WIN2K_XP\(Language)\DISK1

• PCL 6
D:\DRIVERS\PCL6\WIN2K_XP\(Language)\DISK1

• PostScript 3
D:\DRIVERS\PS3\WIN2K_XP\(Language)\DISK1

When installation is complete, the printer connected to “1394_00n” appears in
the [Printers and Faxes] window. (“n” shows the number of printers connected.)

F Follow the on-screen instructions.

Note

❒ If the printer driver has already been installed, the printer icon is added to
the [Printers and Faxes] window. In this case, printer driver installation is
not necessary.

❒ Even if the printer driver is already installed, the message “Found New
Hardware Wizard” may appear when the machine is connected to the
computer using the IEEE 1394 interface cable for the first time. In that case,
install the printer driver.

❒ If printing does not work properly after the installation, delete the port and
reinstall the printer driver. For details, see p.151 “The Machine Does Not
Print”.

❒ If you do not want to install the printer when Found New Hardware Wiz-
ard starts under an operating system that supports SCSI print, disable the
device by following the procedure below:

A When the [Found New Hardware Wizard] dialog box appears, check that
[This wizard helps you install software for: Unknown] is displayed, select the
[Install from a list on specific location (Advanced)] check box, and then click
[Next >].

B When the message “Please choose your search and installation option.”
appears, clear all check boxes from [Search for the best driver in these loca-
tions.], and then click [Next >].

C When the message “The wizard could not find the software on your
computer for..” appears, click [OK].

D When the message “Cannot Install this Hardware” appears, select the
[Don't prompt again to install the software] check box, and then click [Finish].
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Printing with Bluetooth Connection

Supported Profiles

❖ SPP, HCRP

• A maximum of two Bluetooth adaptor or Bluetooth-equipped computers
can be connected at the same time using the Bluetooth interface: one by
SPP, one by HCRP.

• When connecting more than one Bluetooth adaptor or Bluetooth-equipped
computer at the same time, the first device that establishes connection is se-
lected. When selecting the connection between the other devices, cancel
the first established connection.

• Conditions for bidirectional communications

• SPP connection does not support bidirectional communications.

• HCRP connection supports bidirectional communications.

❖ BIP

• For BIP connection, a module including PostScript 3 must be installed in
the machine.

• Only one Bluetooth adaptor or Bluetooth-equipped computer can be con-
nected via BIP.

• Only JPEG images that can be printed using BIP.

• User codes are disabled for BIP.
You cannot print if print functions are restricted.

• Some printers do not support BIP.

Printing with Bluetooth Connection

To install the printer driver, follow the procedure used to install parallel interface.

Important

❒ To install the printer driver under Windows 2000 / XP Professional or Win-
dows Server 2003, you must have an account that has Manage Printers per-
mission. Log on as an Administrators or Power Users group member.

Note

❒ System requirements vary depending on the Bluetooth standard and specifi-
cations. For details, see the manuals supplied with each product.

❒ For information about setting up Bluetooth under other operating systems or
using it with different utilities, see the manuals supplied with those operating
systems or utilities.
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A Start 3Com Bluetooth Connection Manager.

B Check that the printer you want to use appears in 3Com Bluetooth Connec-
tion Manager.

C On the [Tool] menu, click [COM port].

D Check that the message “Bluetooth Serial Client (COMx) “ appears under
Client Ports. (X indicates the COM port number used by Bluetooth.)

E Click [Close].

F On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

G Click the icon of the printer you want to use.

H On the [File] menu, click [Properties].

I Click the [Ports] tab.

J Under [Port], select the [COMx:] check box. X indicates the COM port
number used by Bluetooth.

K Click [OK].

Close the [Printers] window.

❖ If a dialog box appears while transmitting a print job, reestablish network connec-
tion as follows:

A Select the printer you want to use in the [Printers and Faxes] box.

B Click [Connect].

Note

❒ To always use the same printer, select the [Always use for this connection]
check box.

Reference

For details, see the manuals supplied with the Bluetooth adaptor or
computer equipped with Bluetooth.
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Configuring Security Mode Settings

A Start 3Com Bluetooth Connection Manager.

B On the [Tools] menu, click [Security Mode].

The [Security Mode] dialog box appears.

C Select the security mode in the [Security Mode:] list.

If you click [High], or [Custom], and specify [Link] in the [Custom Settings] dialog
box, enter the Bluetooth password. For information about entering the pass-
word, see p.54 “Printing in the Security Mode”.

For all other security modes and custom settings, no password is required.

Note

❒ For information about each mode, see the manuals supplied with the utility.

D Click [OK].

Close the [Security Mode] dialog box.

Reference

For details about the security mode, see 3Com Bluetooth Connection Man-
ager Help. For details about the password entry which is required to trans-
mit print jobs, see p.54 “Printing in the Security Mode”.

Printing in the Security Mode

A Send the print job to the printer in use.

Depending on the computer configuration, the [Connect] dialog box may ap-
pear. If it does, use it to establish the network connection.

B The [Authentication] dialog box appears.

C Enter the Bluetooth password, and then click [OK].

As the Bluetooth password, enter the last four digits of the machine's serial
number. You can find the serial number on the label attached to the back of
the machine. For example, if the serial number is 00A0-001234, the Bluetooth
password is 1234.

D The print job is sent.

Note

❒ The Bluetooth password differs for each machine and cannot be changed.
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If a Message Appears during Installation

Message number 58 or 34 indicates that the printer driver cannot be installed us-
ing Auto Run. Install the printer driver using [Add Printer] or [>Install Printer].

For Windows 95 / 98 / Me, Windows 2000 and Windows NT 4.0:

A On the [Start] menu, point to [Settings], and then click [Printers].

B Double-click the Add Printer icon.

C Follow the instructions in Add Printer Wizard.

Note

❒ If the printer driver is on a CD-ROM, the location of the RPCS printer driver
is either \DRIVERS\RPCS\WIN9X_ME, \DRIVERS\RPCS\WIN2K_XP,
or \DRIVERS\RPCS\NT4. If the installer starts, click [Cancel] to quit.

For Windows XP Professional and Windows Server 2003:

A On the [Start] menu, click [Printers and Faxes].

B Click [Add a printer].

C Follow the instructions in Add Printer Wizard.

Note

❒ If the printer driver is on a CD-ROM, the location of the RPCS printer driver
is \DRIVERS\RPCS\WIN2K_XP. If the installer starts, click [Cancel] to quit.

For Windows XP Home Editions:

A On the [Start] menu, click [Printers and Faxes].

B Click [Add a Printer].

C Follow the instructions in Add Printer Wizard.

Note

❒ If the printer driver is on a CD-ROM, the location of the RPCS printer driver
is \DRIVERS\RPCS\WIN2K_XP. If the installer starts, click [Cancel] to quit.
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Making Option Settings for the Printer

Make option settings for the machine using the printer driver when bidirectional
communication is disabled.

Reference

For details about making option settings for the printer, see p.58 “If Bidirec-
tional Communication Is Disabled”.

Conditions for Bidirectional Communication

Bidirectional communication allows information about paper size and feed di-
rection settings to be automatically sent to the printer. You can check machine
status from your computer.

• Bidirectional communication is supported by Windows 95 / 98 / Me / 2000 /
XP, Windows Server 2003, and Windows NT 4.0.

• If you use the RPCS printer driver and bidirectional communication is ena-
bled under Windows 2000, the [Change Accessories] tab is unavailable. 

Note

❒ The RPCS printer driver supports bidirectional communications and updates
the machine status automatically.

❒ The PCL printer driver supports bidirectional communications. You can up-
date the machine status manually.

❒ The PostScript 3 printer driver does not support bidirectional communica-
tions.

To support bidirectional communication, the following conditions must be met:

❖ When connected with parallel cables

• The computer must support bidirectional communication.

• The machine must support bidirectional communication.

• The interface cable must support bidirectional communication.

• The machine must be connected to the computer using the standard paral-
lel cables and parallel connectors.

• Under Windows 2000, [Enable bidirectional support] must be selected, and
[Enable printer pooling] must not be selected on the [Ports] tab with the RPCS
printer driver.
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❖ When connected with the network

• The machine must support bidirectional communication.

• SmartDeviceMonitor for Client included on the CD-ROM must be installed,
and TCP/IP must be used.

• Under Windows 2000, [Enable bidirectional support] must be selected, and
[Enable printer pooling] must not be selected on the [Ports] tab with the RPCS
printer driver.

• In addition to the above, one of the following conditions must also be met:

• The SmartDeviceMonitor for Client port and the TCP/IP protocol must
be used.

• The standard TCP/IP port must be used without changing the default
port name (for Windows 2000 / XP and Windows Server 2003).

• Microsoft TCP/IP print IP address must be specified for use (for Win-
dows NT 4.0).

• IPP port name must include the IP address when using the IPP protocol.

❖ When connected with IEEE 1394

• The computer must support bidirectional communication.

• The machine must be connected to the IEEE 1394 connector of a computer
using the IEEE 1394 interface cable.

• [Activate] must be selected in the SCSI print of IEEE 1394 and [Activate] must
be selected in the Bidi-SCSI print.

• Under Windows 2000 / XP or Windows Server 2003, [Enable bidirectional
support] must be selected, and [Enable printer pooling] must not be selected
on the [ports] tab with RPCS printer driver.

❖ When connected with USB
The machine must be connected to the computer's USB port using the USB in-
terface cable.
The computer must support bidirectional communication.

Note

❒ Install SmartDeviceMonitor for Client from the supplied CD-ROM.
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If Bidirectional Communication Is Disabled

Set up option settings when bidirectional communications are disabled.

Limitation

❒ Under Windows 2000 / XP and Windows Server 2003, Manage Printers per-
mission is required to change the printer properties in the [Printers] folder.
Log on as an Administrators or Power Users group member.

❒ Under Windows NT 4.0, Full Control permission is required to change the
printer properties in the [Printers] folder. Log on as an Administrators or Pow-
er Users group member.

A On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].

D Click the [Accessories] tab.

If options in the [Change Accessories] tab are disabled, bidirectional connection
is enabled. In this case, no change is necessary for option settings.

Note

❒ If you are using the RPCS printer driver, click the [Change Accessories] tab.

❒ If you are using the PS printer driver, click the [Device Settings] tab.

E Select options installed from the [Options] area, and then make the neces-
sary settings.

F Select the total amount of the memory in [Total memory:] when the optional
SDRAM module is added.

G Under [Paper source tray settings:], click and highlight the tray to be used, and
then select the appropriate size, position, and type for the tray. Select the
[Tray locking] check box to exclude the tray from the targets of automatic tray
selection.

H Click [OK] to close the printer properties dialog box. Click the [Defaults] tab,
and then click [Change Accessories] to display the option selection.

Click [OK] to close the printer properties dialog box. Click the [Defaults] tab,
and then click [Change Accessories] to display the option selection.
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Installing Font Manager 2000

Limitation

❒ Under Windows 2000 / XP, Windows Server 2003, or Windows NT 4.0, install-
ing applications by Auto Run requires administrator permission. To install a
printer driver by Auto Run, log on using an account that has administrator
permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

C Click [Font Manager 2000].

D Follow the instructions on the screen.
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Using Adobe PageMaker Version 6.0, 6.5, 
or 7.0

Under Windows 95 / 98 / Me / 2000 / XP, Windows Server 2003, or Windows NT
4.0 with Adobe PageMaker, you need to copy PPD files to the PageMaker folder.

PPD files have the .ppd extension in the folder “DRIVERS\PS\WIN9X_ME\(Lan-
guage)\DISK1\” on the CD-ROM.

The “WIN9X_ME” folder inside the “PS” folder is for Windows 95 / 98 / Me.
Use the folder at this level that is appropriate for the operating system you are
currently using.

The third folder “(Language)” may be substituted by an appropriate language
name.

Copy the .ppd file to the PageMaker folder.

• For PageMaker 6.0 default installation 
The directory is “C:\PM6\RSRC\PPD4”.

• For PageMaker 6.5 default installation 
The directory is “C:\PM65\RSRC\USENGLISH\PPD4”.
The “USENGLISH” may vary depending on your language selection.

• For PageMaker 7.0 default installation 
The directory is “C:\PM7\RSRC\USENGLISH\PPD4”.
The “USENGLISH” may vary depending on your language selection.

Note

❒ If the driver is not set correctly after copying the “.ppd” file, printing may not
be performed properly.

❒ When using PageMaker, the optional features that can be selected by the
printer driver will not be active. The following procedure describes how to
activate the optional printer features.

A On the [File] menu, click [Print].
The [Print Document] dialog box appears.

B Make the necessary settings in the [Features] box.



61

3. Setting Up the Printer Driver

PCL - Accessing the Printer Properties

Windows 95 / 98 / Me - Accessing the Printer Properties

There are two methods to open the printer properties dialog box.

Making Printer Default Settings

To make the printer default settings, open the printer properties dialog box from
the [Printers] window.

Important

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].

DMake the necessary settings, and then click [OK].

Note

❒ With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

Reference

For details, see Printer Driver Help. 

Making Printer Settings from an Application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 95 / 98 / Me.

A On the [File] menu, click [Print].

The [Print] dialog box appears.

B Select the printer you want to use in the [Name] list, and then click [Properties].

The printer properties dialog box appears.

CMake the necessary settings, and then click [OK].
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D Click [OK] to start printing.

Note

❒ The procedure to open the printer properties dialog box may vary depend-
ing on the application. For details, see the manuals provided with the ap-
plication you use.

❒ With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

Reference

For details, see Printer Driver Help. 

Windows 2000 - Accessing the Printer Properties

Making Printer Default Settings - The Printer Properties

Important

❒ To change the printer default settings including option configuration settings,
log on using an account that has Manage Printers permission. Members of the
Administrator and Power Users groups have Manage Printers permission by
default.

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].

The printer properties dialog box appears.

DMake the necessary settings, and then click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.

❒ Do not make a setting for [Form to Tray Assignment].

Reference

For details, see Printer Driver Help. 
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Making Printer Default Settings - Printing Preferences

Important

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

DMake the necessary settings, and then click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.

Reference

For details, see Printer Driver Help. 

Making Printer Settings from an Application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 2000.

Note

❒ The procedure to open the [Printing Preferences] dialog box may vary depend-
ing on the application. For details, see the manuals provided with the appli-
cation you use.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

A On the [File] menu, click [Print...].

The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] list.

CMake the necessary settings, and then click [Apply] to start printing.

Reference

For details, see Printer Driver Help. 
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Windows XP, Windows Server 2003 - Accessing the Printer 
Properties

Making Printer Default Settings - The Printer Properties

Important

❒ To change the printer default settings including option configuration settings,
log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default. 

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].

The printer properties dialog box appears.

DMake the necessary settings, and then click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.

❒ Do not make a setting for [Form to Tray Assignment].

Reference

For details, see Printer Driver Help. 
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Making Printer Default Settings - Printing Preferences

Important

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

DMake the necessary settings, and then click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.

Reference

For details, see Printer Driver Help. 

Making Printer Settings from an Application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows XP.

Note

❒ The procedure to open the [Printing Preferences] dialog box may vary depend-
ing on the application. For details, see the manuals provided with the appli-
cation you use.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

A On the [File] menu, click [Print...].

The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] list.

CMake the necessary settings, and then click [Apply] to start printing.

Reference

For details, see Printer Driver Help. 



Setting Up the Printer Driver

66

3

Windows NT 4.0 - Accessing the Printer Properties

Making Printer Default Settings - The Printer Properties

Important

❒ To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default. 

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].

The printer properties dialog box appears.

DMake the necessary settings, and then click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.

❒ Do not make a setting for [Form to Tray Assignment].

Reference

For details, see Printer Driver Help. 

Making Printer Default Settings - Default

Important

❒ To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default. 

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Document Defaults].

The [Default] dialog box appears.
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DMake the necessary settings, and then click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.

Reference

For details, see Printer Driver Help. 

Making Printer Settings from an Application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows NT 4.0.

Note

❒ The procedure to open the printer properties dialog box may vary depending
on the application. For details, see the manuals provided with the application
you use.

❒ With some applications, the printer driver settings are not used, and the ap-
plication's own default settings are applied.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

A On the [File] menu, click [Print].

The [Print] dialog box appears.

B Select the printer you want to use in the [Name] list, and then click [Proper-
ties].

The printer properties dialog box appears.

CMake the necessary settings, and then click [OK].

D Click [OK] to start printing.

Reference

For details, see Printer Driver Help. 
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RPCS - Accessing the Printer Properties

Windows 95 / 98 / Me - Accessing the Printer Properties

There are two dialog box types of the printer properties dialog box.

“Multi-tab” is used as an example in this manual. For details about changing the
dialog box types, see the printer driver Help.

❖ Multi-tab
This dialog box type is designed for users who often change print settings to
perform various printing operations.

❖ Custom Setting
This dialog box type is designed for users who rarely change print settings.
This type of dialog box may vary depending on the installed options.

Making Printer Default Settings

To make the printer default settings, open the printer properties dialog box from
the [Printers] window.

Important

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

Note

❒ With some applications, the printer driver settings are not used, and the ap-
plication's own default settings are applied.

A On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].

Note

❒ When you open the printer properties dialog box initially after installing
the RPCS printer driver, a confirmation message appears. After clicking
[OK], the printer properties dialog box appears.

DMake the necessary settings, and then click [OK].

Reference

For details, see Printer Driver Help. 
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Making Printer Settings from an Application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 95 / 98 / Me.

Note

❒ The procedure to open the printer properties dialog box may vary depending
on the application. For details, see the manuals provided with the application
you use.

❒ With some applications, the printer driver settings are not used, and the ap-
plication's own default settings are applied.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

A On the [File] menu, click [Print].

The [Print] dialog box appears.

B Select the printer you want to use in the [Name] list, and then click [Proper-
ties].

The printer properties dialog box appears.

CMake the necessary settings, and then click [OK].

D Click [OK] to start printing.

Reference

For details, see Printer Driver Help. 
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Windows 2000 - Accessing the Printer Properties

Making Printer Default Settings - The Printer Properties

Important

❒ To change the printer default settings including option configuration settings,
log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default. 

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].

The printer properties dialog box appears.

Note

❒ When you open the printer properties dialog box initially after installing
the RPCS printer driver, a confirmation message appears. After clicking
[OK], the printer properties dialog box appears.

DMake the necessary settings, and then click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.

❒ Do not make a setting for [Form to Tray Assignment].

Reference

For details, see Printer Driver Help. 
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Making Printer Default Settings - Printing Preferences

Important

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

DMake the necessary settings, and then click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.

Reference

For details, see Printer Driver Help. 

Making Printer Settings from an Application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 2000.

Note

❒ The procedure to open the [Printing Preferences] dialog box may vary depend-
ing on the application. For details, see the manuals provided with the appli-
cation you use.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

A On the [File] menu, click [Print...].

The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] list.

CMake the necessary settings, and then click [Apply] to start printing.

Reference

For details, see Printer Driver Help. 
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Windows XP, Windows Server 2003 - Accessing the Printer 
Properties

Making Printer Default Settings - The Printer Properties

Important

❒ To change the printer default settings including option configuration settings,
log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default. 

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].

The printer properties dialog box appears.

Note

❒ When you open the printer properties dialog box initially after installing
the RPCS printer driver, a confirmation message appears. After clicking
[OK], the printer properties dialog box appears.

DMake the necessary settings, and then click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.

❒ Do not make a setting for [Form to Tray Assignment].

Reference

For details, see Printer Driver Help. 
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Making Printer Default Settings - Printing Preferences

Important

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

DMake the necessary settings, and then click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.

Reference

For details, see Printer Driver Help. 

Making Printer Settings from an Application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows XP.

Note

❒ The procedure to open the [Printing Preferences] dialog box may vary depend-
ing on the application. For details, see the manuals provided with the appli-
cation you use.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

A On the [File] menu, click [Print...].

The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] list.

CMake the necessary settings, and then click [Apply] to start printing.

Reference

For details, see Printer Driver Help. 
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Windows NT 4.0 - Accessing the Printer Properties

Making Printer Default Settings - The Printer Properties

Important

❒ To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].

The printer properties dialog box appears.

Note

❒ When you open the printer properties dialog box initially after installing
the RPCS printer driver, a confirmation message appears. After clicking
[OK], the printer properties dialog box appears.

DMake the necessary settings, and then click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.

❒ Do not make a setting for [Form to Tray Assignment].

Reference

For details, see Printer Driver Help. 
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Making Printer Default Settings - Default

Important

❒ To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default. 

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Document Defaults...].

The [Default] dialog box appears.

DMake the necessary settings, and then click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.

Reference

For details, see Printer Driver Help. 

Making Printer Settings from an Application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows NT 4.0.

Note

❒ The procedure to open the printer properties dialog box may vary depending
on the application. For details, see the manuals provided with the application
you use.

❒ With some applications, the printer driver settings are not used, and the ap-
plication's own default settings are applied.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

A On the [File] menu, click [Print].

The [Print] dialog box appears.
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B Select the printer you want to use in the [Name] list, and then click [Properties].

The printer properties dialog box appears.

CMake the necessary settings, and then click [Apply].

D Click [OK] to start printing.

Reference

For details, see Printer Driver Help. 
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4. Other Print Operations

Printing a PDF File Directly

You can send PDF files directly to the
machine for printing, without having
to open a PDF application.

Limitation

❒ This function is possible only when
the optional PostScript 3 unit is in-
stalled.

❒ This function is possible for genu-
ine Adobe PDF files only.

❒ Version 1.3, 1.4, and 1.5 PDF files
are compatible.

❒ Transparency and JBIG2 (functions
of PDF version 1.4) are not compati-
ble.

❒ PDF version 1.5 exclusive functions
are not compatible. 

Note

❒ Paper size errors may occur when
printing on custom size paper.

Printing Method

❖ Using DeskTopBinder Lite
PDF files registered with Desk-
TopBinder Lite can be sent directly
to the machine for printing.

Limitation

❒ Use DeskTopBinder Lite in the
supplied CD-ROM.

Note

❒ PDF Direct Print settings can be
made from PDF Direct Print
properties. 

❒ When printing PDF files for
which a password is set, one of
the following settings is re-
quired:

• Enter the PDF password from
PDF Direct Print properties.
The RPCS printer driver must
be installed. 

• To set the PDF password, se-
lect [Change PDF Password] on
the [PDF Menu] in Printer Fea-
tures.

❒ When a group password is set
with DeskTopBinder Lite, set a
group password using [PDF
Group Password] on the [PDF
Menu] in Printer Features.

Reference

For details, see DeskTopBinder
Lite Help.

❖ Using commands
From UNIX, you can print PDF
files directly, using commands
such as “ftp” and “lpr”.
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Unauthorized Copy Control

You can embed patterns and text under printed text to prevent unauthorized
copying of the document. Unauthorized Copy Control consists of two functions:
[Data security for copying] and [Mask type:].

Important

❒ This function is designed to discourage copying of confidential documents; it
does not prevent unauthorized use of information.

Using [Data security for copying]

You can embed a pattern by setting it in the printer driver.

❖ Setting [Data security for copying] in the printer driver

• Select the [Data security for copying] checkbox. You can also enter the text in
the [Text:] box.

• You cannot select the [Mask type:] checkbox at the same time.

• To print a document protected by gray overprint, the machine must be set
up correctly. Consult an administrator.
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❖ Printing a document using [Data security for copying]

1. The print preview of the pattern
and text you have set is displayed.

2. The document is copied or stored
in this machine or another copi-
er/multifunction machine where the
optional Copy Data Security unit is
installed.

3. The document is blanked by gray
overprint.

Reference

For details about setting [Data security for copying], see Printer Driver Help.

Limitation

❒ When printing a document that is set with [Data security for copying], the ma-
chine does not require the optional Copy Data Security unit to be installed.
The Copy Data Security unit is required when copying or storing a docu-
ment protected by gray overprint.

❒ Only the RPCS printer driver is supported.

❒ Printing at 200 dpi is not possible.

❒ You cannot partially embed a pattern and text in a document.

❒ Use 182 × 257 mm (71/4 × 101/2 in.) or larger paper.

❒ Use ordinary or recycled paper of at least 70% whiteness.

❒ Duplex printing may interfere with this function as a result of text and pat-
terns being visible through the paper.
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Using [Mask type:]

You can embed patterns and text in a document by setting in the printer driver
to prevent unauthorized copying.

❖ Setting [Mask type:] in the printer driver

• Select a pattern from [Mask type:], and then enter text in the [Text:] box.

Note

❒ You can set only [Text:], but [Mask type:] and [Text:] must be set together.

❖ Printing a document using [Mask type:]

1. The print preview of the pattern
and text you have set is displayed.

2. The document is copied, scanned,
or stored in this machine or another
copier/multifunction machine.

3. The pattern and text you have set
appear.
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Reference

For details about setting [Mask type:], see Printer Driver Help.

Limitation

❒ Only the RPCS printer driver is supported.

❒ Printing at 200 dpi is not possible.

❒ You cannot partially embed patterns and text strings in a document.

Note

❒ Due to the effects of the settings, the results of copying, scanning, and saving
documents in the document server may vary depending on the machine
model and setting conditions.

❒ Printing with background patterns and text may be slower than normal printing.

Important Notice

• Ricoh does not provide warranty regarding the appearance of print patterns
and other copy protection features. The appearance of the print patterns and
the performance of Unauthorized Copy Control may vary depending on the
quality of paper used and the machine model and settings.

• Ricoh takes no responsibility for any damages sustained in connection with
use of or inability to make use of Unauthorized Copy Control print patterns.
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Using the Print Job List

Print files stored in the machine can be printed. You can select the print files
from the Complete List or List Per User ID screen. 

Selecting the Initial Print Job List

For the print job list, select one of the two display types:

• Complete List: displays a list of saved print jobs.

• List Per User ID: displays a list of user IDs.

Reference

For details about list types, see p.83 “Displaying a Print Job List”.

A Press the {User Tools/Counter} key.

The User Tools / Counter menu appears.

B Press [Printer Features].

The Printer Features menu appears.

C On the [System] tab, press [Initial Print Job List].

D Select either [Complete List] or [List Per User ID].

After configuring the settings, the selected type of print job list is displayed.



Using the Print Job List

83

4

Displaying a Print Job List

A list of files stored in the machine can be viewed on the display panel.

A Press the {Printer} key.

The Printer screen appears.

B Press [Print Jobs].

Either the Complete List or List Per User ID screen appears, depending on the
[Initial Print Job List] setting in [System] of [Printer Features]. For details, see p.82
“Selecting the Initial Print Job List”.

❖ Complete List
If you select [Complete List] from [Initial Print Job List] (see p.82 “Selecting the
Initial Print Job List”), the following screen appears:

1. [Complete List]

Displays all files stored in the ma-
chine.

2. [Locked Print Job List]

Displays only Locked Print files
stored in the machine. See p.89
“Locked Print”.

AJO030S

AJO010S
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3. [Sample Print Job List]

Displays only Sample Print files
stored in the machine. See p.86 “Sam-
ple Print”.

4. [Hold Print Job List]

Displays only Hold Print files stored
in the machine. See p.92 “Hold Print”.

5. [Stored Print Job List]

Displays only Stored Print files stored
in the machine. See p.95 “Stored
Print”.

6. User ID, Date/Time, and File
Name display

Displays the time when the instruc-
tion to print the stored files was en-
tered, User ID, and the file names.

7. [UPrev.] / [TNext.]

If the list of files does not fit on the
screen, scroll down to view the list.

8. [Exit]

Returns to the Printer screen.

9. [Details]

Displays details about a selected file.

10. [Select All Jobs]

Selects all files stored in the machine.

11. [Clear All]

Clears all selections.

12. [Print]

Prints a selected file.

13. [Delete]

Deletes a selected file.

❖ List Per User ID
If you select [List Per User ID] from [Initial Print Job List] (see p.82 “Selecting
the Initial Print Job List”), the following screen appears: 

1. [Clear]

Deselects a selection.

2. User ID

Displays user IDs who sent files to the
machine.

3. [UPrev.] / [TNext.]

If the list of files does not fit on the
screen, scroll down to view the list.

4. [Exit]

Returns to the Printer screen.

5. [Complete List]

Displays all print jobs.

6. [List Per User ID]

Displays the print job list of each ID.

7. [Print All Jobs]

Prints all documents of the desired ID.
If a user sends a different type of print
jobs in the same ID, you can select
which type of a print job to print.

AJO020S
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Reference

For details about printing from the List Per User ID screen, see p.98 “Print-
ing from List Per User ID”.

Note

❒ The display is not updated if a new file is stored while the list of stored files
is displayed. To update the display, press [Exit] to return to the Printer
screen, and then press [Print Jobs] again.

❒ To store files in the machine, you can use the Document Server as well as
Sample Print, Locked Print, Hold Print, or Stored Print. See p.135 “Using
the Document Server”.

❒ Select the required ID before pressing [List Per User ID] (6) or [Print All Jobs]
(7).

❒ If a large number of print jobs are stored in the machine, processing may
slow down temporarily, depending on which functions are used.

❒ If you press [Per User ID] in the Complete List screen, the screen switches to
the List Per User ID screen where [Back] appears at the bottom right. Press
[Back] to switch to the Complete List screen.
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Sample Print

Use this function to print only the first
set of a multiple-set print job. After
you have checked the result, remain-
ing sets can be printed or canceled us-
ing the machine's control panel. This
can reduce misprints due to mistakes
in content or settings.

Limitation

❒ A Sample Print file cannot be stored
if:

• the total number of Sample Print,
Locked Print, Hold Print, and
Stored Print files in the machine
is over 100. (The maximum
number varies depending on the
volume of data in files.)

• the file contains over 1,000 pages.

• sent or stored files in the machine
contain over 9,000 pages in total.

Note

❒ If a Sample Print file has not been
stored properly, check the error
log on the control panel (see p.105
“Checking the Error Log”).

❒ Even after you turn off the ma-
chine, stored documents in the ma-
chine remain. However, the [Auto
Delete Temporary Print Jobs] or [Auto
Delete Stored Print Jobs] settings are
applied first (see p.128 “System”).

❒ If the application has a collate op-
tion, make sure it is not selected be-
fore sending a print job. By default,
Sample Print jobs are automatically
collated by the printer driver. If a
collate option is selected from the
application's [Print] dialog box,
more prints than intended may be
produced.

❒ If the first set of the Sample Print
files is not as you expected and you
do not want to print remaining
sets, delete the Sample Print file
using the display panel. If you
print the remaining sets of the
Sample Print file, the job in the ma-
chine is deleted automatically.

Printing a Sample Print File

The following procedure describes
how to print a Sample Print file with
the PCL 6 / 5e and the RPCS printer
driver. For information about how to
print a Sample Print file with the
PostScript 3 printer driver, see Post-
Script 3 Supplement included as a PDF
file on the CD-ROM.

Limitation

❒ Applications with their own driv-
ers, such as PageMaker, do not
support this function.

❒ If you are using Mac OS X, you need
Mac OS X v10.2 or higher to use this
function.

Note

❒ The following procedure describes
when you select [Complete List]
from [Initial Print Job List] (see p.82
“Selecting the Initial Print Job
List”).

A Configure Sample Print in the
printer driver's properties.

Reference

For details about configuring
the printer drivers, see the rele-
vant Help files.
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B Start printing from the applica-
tion's [Print] dialog box.

Note

❒ Make sure to set more than two
copies.

The Sample Print job is sent to the
machine, and the first set is printed.

C On the machine's control panel,
press the {Printer} key to display
the Printer screen.

D Press [Print Jobs].

A list of print files stored in the ma-
chine appears.

E Press [Sample Print Job List].

A list of Sample Print files stored in
the machine appears.

The following items also appear:

• User ID: The user ID set up by
the printer driver.

• Date / Time:: The date and time
when the job was sent from the
computer.

• File Name: The name of files
stored in the machine.

Note

❒ Depending on the security set-
tings, certain print jobs may not
be displayed.

F Select the file you want to print
by pressing it.

Note

❒ To select all print jobs, press [Se-
lect All Jobs].

❒ Press [UPrev.] or [TNext.] to
scroll through the list.

❒ To cancel a selection, press the
highlighted print job again. To
clear all selections, press [Clear
All].

❒ To view details about a selected
print file, press [Details].

G Press [Print] to change the number
of sets to be printed.

AJO030S
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H Enter the new number of sets us-
ing the number keys.

If you do not want to change the
set quantity, proceed to step I.

Note

❒ You can enter up to 999 sets.

❒ Press {Clear/Stop} to correct any
entry mistakes.

❒ When multiple files are selected
without setting a quantity, 1
page less than the minimum
number of all settings is ap-
plied.

❒ When the number of set quanti-
ty is changed, the changed
quantity is applied to all select-
ed files.

I Press [Yes].

The remaining sets are printed.

Important

❒ When printing is completed, the
stored file is deleted.

Note

❒ Press [No] to cancel printing.

❒ To stop printing after printing
has started, press [Exit], and
then press [Job Reset]. The file is
deleted.

❒ Remaining print jobs are print-
ed before the Sample Print job.

Deleting Sample Print Files

If you are not satisfied with the sam-
ple printout, you can delete the Sam-
ple Print file, revise it and print it
again until the settings are suitable.

A Press the {Printer} key to display
the Printer screen.

B Press [Print Jobs].

A list of print files stored in the ma-
chine appears.

C Press [Sample Print Job List].

A list of Sample Print files stored in
the machine appears.

Note

❒ Depending on the security set-
tings, certain print jobs may not
be displayed.

D Select the file you want to delete
by pressing it.

E Press [Delete].

The delete confirmation screen
will appear.

F Press [Yes] to delete the file.

After the file has been deleted, the
file list screen will return.

Note

❒ If you do not want to delete the
file, press [No].
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Locked Print

Use this function to maintain privacy
when printing confidential documents
on the machine over a shared network.
Usually, it is possible to print data us-
ing the display panel once it is stored in
this machine. When using Locked
Print, it is not possible to print unless a
password is entered on the machine's
display panel. Your confidential docu-
ments will be safe from being viewed
by other people.

Limitation

❒ A Locked Print file cannot be stored
if:

• the total number of Sample Print,
Locked Print, Hold Print, and
Stored Print files in the machine
is over 100. (The maximum
number varies depending on the
volume of data in files.)

• the file contains over 1,000 pages.

• sent or stored files in the machine
contain over 9,000 pages in total.

Note

❒ If a Locked Print file has not been
stored properly, check the error
log on the control panel (see p.105
“Checking the Error Log”).

❒ Even after you turn off the ma-
chine, stored documents remain.
However, the [Auto Delete Tempo-
rary Print Jobs] or [Auto Delete Stored
Print Jobs] settings are applied first
(see p.128 “System”).

❒ If the application has a collate op-
tion, make sure it is not selected
before sending a print job. Locked
Print jobs are automatically collat-
ed by the printer driver as default.
If a collate option is selected in the
application print dialog box, more
sets than intended may be printed.

❒ After the Locked Print file is print-
ed, the job is automatically deleted.

Printing a Locked Print File

The following procedure describes
how to print a Locked Print file with
the PCL 6 / 5e and the RPCS printer
driver. For information about how to
print a Locked Print file with the Post-
Script 3 printer driver, see PostScript 3
Supplement included as a PDF file on
the CD-ROM.

Limitation

❒ Applications with their own driv-
ers, such as PageMaker, do not
support this function.

❒ If you are using Mac OS X, you
need Mac OS X v10.2 or higher to
use this function.

Note

❒ The following procedure describes
when you select [Complete List]
from [Initial Print Job List] (see p.82
“Selecting the Initial Print Job
List”).

A Configure the Locked Print in the
printer driver's properties.

Reference

For details about configuring
the printer drivers, see the cor-
responding Help files.

B Start printing from the applica-
tion's [Print] dialog box.

The Locked Print job is sent to the
machine.

C On the machine's control panel,
press the {Printer} key to display
the Printer screen.
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D Press [Print Jobs].

A list of print files stored in the ma-
chine appears.

E Press [Locked Print Job List].

A list of Locked Print files stored in
the machine appears.

The following items also appear:

• User ID: The user ID set up by
the printer driver.

• Date / Time: The date and time
when the job was sent from the
computer.

Note

❒ If Locked Print is selected, file
names are displayed as “*****”
on the screen to prevent unau-
thorized viewing.

❒ Depending on the security set-
tings, certain print jobs may not
be displayed.

F Select the file you want to print
by pressing it.

Note

❒ To select all print jobs, press [Se-
lect All Jobs].

❒ Press [UPrev.] or [TNext.] to
scroll through the list.

❒ To cancel a selection, press the
highlighted print job again. To
clear all selections, press [Clear
All].

❒ To view details about a selected
print file, press [Details].

G Press [Print].

The password screen appears.

H Enter the password using the
number keys, and then press [OK].

The print confirmation screen ap-
pears.

Note

❒ A confirmation screen will ap-
pear if the password is not en-
tered correctly. Press [OK] to
enter the password again.

❒ When multiple print files are se-
lected, the machine prints only
files that correspond to the en-
tered password. The number of
files is displayed on the confir-
mation screen.
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I Press [Yes].

The locked file is printed.

Important

❒ When printing is completed, the
stored file is deleted.

Note

❒ Press [No] to cancel printing.

❒ To stop printing after printing
has started, press [Exit], and
then press [Job Reset]. The file
will be deleted.

Deleting Locked Print Files

A Press the {Printer} key to display
the Printer screen.

B Press [Print Jobs].

A list of print files stored in the ma-
chine appears.

C Press [Locked Print Job List].

A list of Locked Print files stored
appears.

Note

❒ Depending on the security set-
tings, certain print jobs may not
be displayed.

D Select the file you want to delete
by pressing it.

E Press [Delete].

The password screen is displayed.

F Enter the password using the
number keys, and then press [OK].

The delete confirmation screen ap-
pears.

Note

❒ A confirmation screen will ap-
pear if the password is not en-
tered correctly. Press [OK] to
enter the password again.

❒ When multiple files are select-
ed, the machine deletes only
files that correspond to the en-
tered password. The number of
files to be deleted is displayed
on the confirmation screen.

G Press [Yes].

After the file has been deleted, the
file list screen returns.

Note

❒ If you do not want to delete the
file, press [No].
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Hold Print

Use this function to temporarily hold
a file in the machine, and print it from
the computer or the machine's control
panel later.

Limitation

❒ A Hold Print file cannot be stored
if:

• the total number of Sample Print,
Locked Print, Hold Print, and
Stored Print files in the machine
is over 100. (The maximum
number varies depending on the
volume of data in files.)

• the file contains over 1,000 pages.

• sent or stored files in the machine
contain over 9,000 pages in total.

Note

❒ If a Hold Print file has not been
stored properly, check the error
log on the control panel (see p.105
“Checking the Error Log”).

❒ Even after you turn off the ma-
chine, stored documents in the ma-
chine remain. However, the [Auto
Delete Temporary Print Jobs] or [Auto
Delete Stored Print Jobs] settings are
applied first (see p.128 “System”).

❒ If the application has a collate op-
tion, make sure it is not selected
before sending a print job. By de-
fault, Hold Print jobs are automat-
ically collated by the printer
driver. If a collate option is select-
ed from the application's Print dia-
log box, more prints than intended
may be produced.

Printing a Hold Print File

The following procedure describes
how to print a Hold Print file with the
RPCS printer driver. For information
about how to print a Hold Print file
with the PostScript 3 printer driver,
see Postscript 3 supplement included as
a PDF file in the supplied CD-ROM.

Limitation

❒ Applications with their own driv-
ers, such as PageMaker, do not
support this function.

❒ If you are using Mac OS X, you
need Mac OS X v10.2 or higher to
use this function.

Reference

For details about setting printer
drivers, see Printer Driver Help.
You can also print or delete a Hold
Print file from Web Image Moni-
tor. For details, see Web Image
Monitor Help.

Note

❒ The following procedure describes
when you select [Complete List]
from [Initial Print Job List] (see p.82
“Selecting the Initial Print Job
List”).

A Configure Hold Print in the print-
er driver’s properties.

Reference

For details about configuring
the printer drivers, see the rele-
vant Help files.

B Click [Details...], and then enter a
User ID in the [User ID:] box.
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C Start printing from the applica-
tion’s [Print] dialog box.

The Hold Print job is sent to the
machine and stored.

D On the machine’s control panel,
press the {Printer} key to display
the printer screen.

E Press [Print Jobs].

A list of print files stored in the ma-
chine appears.

F Press [Hold Print Job List].

 A list of print files stored in the
machine appears.

The following items also appear: 

• User ID: The user ID set up by
the printer driver. 

• Date / Time: The date and time
when the job was sent from the
computer.

• File Name: The name of files
stored in the machine.

Note

❒ Depending on the security set-
tings, certain print jobs may not
be displayed.

G Select the file you want to print
by pressing it.

Note

❒ To select all print jobs, press [Se-
lect All Jobs].

❒ Press [UPrev.] or [TNext.] to
scroll through the list.

❒ To cancel a selection, press the
highlighted print job again. To
clear all selections, press [Clear
All].

❒ To view details about the select-
ed print file, press [Details].

H Press [Print].

The confirmation screen appears.

I Press [Yes].

The Hold Print file is printed.

Important

❒ When printing is completed, the
stored file is deleted.

Note

❒ Press [No] to cancel printing.

❒ To stop printing after printing
has started, press [Exit], and
then press [Job Reset]. The file is
deleted.
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Deleting Hold Print Files

A Press the {Printer} key to display
the Printer screen.

B Press [Print Jobs].

A list of print files stored in the ma-
chine appears.

C Press [Hold Print Job List].

A list of Hold Print files stored in
the machine appears.

Note

❒ Depending on the security set-
tings, certain print jobs may not
be displayed.

D Select the file you want to delete
by pressing it.

E Press [Delete].

The delete confirmation screen
will appear.

F Press [Yes] to delete the file.

After the file has been deleted, the
file list screen will return.

Note

❒ If you do not want to delete the
file, press [No].
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Stored Print

Use this function to store a file in the
machine, and then print it from the
computer or the machine's control
panel later.

Limitation

❒ A Stored Print file cannot be stored
if:

• the total number of Sample Print,
Locked Print, Hold Print, and
Stored Print files in the machine
is over 100. (The maximum
number varies depending on the
volume of data in files.)

• the file contains over 1,000 pages.

• sent or stored files in the machine
contain over 9,000 pages in total.

Note

❒ If a Stored Print file has not been
stored properly, check the error
log on the control panel (see p.105
“Checking the Error Log”).

❒ Even after you turn off the ma-
chine, stored documents remain.
However, the [Auto Delete Tempo-
rary Print Jobs] or [Auto Delete Stored
Print Jobs] settings are applied first
(see p.128 “System”).

❒ If the application has a collate op-
tion, make sure it is not selected
before sending a print job. By de-
fault, Stored Print jobs are auto-
matically collated by the printer
driver. If a collate option is select-
ed from the application's Print dia-
log box, more prints than intended
may be produced.

Printing a Stored Print File

The following procedure describes
how to print a Stored Print file with
the RPCS printer driver. For informa-
tion about how to print a Stored Print
file with the PostScript 3 printer driv-
er, see Postscript 3 supplement includ-
ed as a PDF file on the supplied CD-
ROM.

Limitation

❒ Applications with their own driv-
ers, such as PageMaker, do not
support this function.

❒ If you are using Mac OS X, you
need Mac OS X v10.2 or higher to
use this function.

Reference

For details about setting printer
drivers, see Printer Driver Help.
You can also print or delete a
Stored Print file from Web Image
Monitor. For details, see Web Im-
age Monitor Help.

Note

❒ The following procedure describes
when you select [Complete List]
from [Initial Print Job List] (see p.82
“Selecting the Initial Print Job
List”).

A Configure Stored Print in the
printer driver’s properties.

Reference

For details about configuring
the printer drivers, see the rele-
vant Help files.
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B Click [Details...], and then enter a
User ID in the [User ID:] box.

Note

❒ You can also set a password. The
same password must be entered
when printing or deleting.

C Start printing from the applica-
tion’s [Print] dialog box.

The Stored Print job is sent to the
machine and stored.

D On the machine’s control panel,
press the {Printer} key to display
the printer screen.

E Press [Print Jobs].

A list of print files stored in the ma-
chine appears.

F Press [Stored Print Job List].

A list of Stored Print files stored in
the machine appears.

The following items also appear:

• User ID: The user ID set up by
the printer driver. 

• Date / Time: The date and time
when the job was sent from the
computer.

• File name: The name of files
stored in the machine.

 

G Select the file you want to print
by pressing it.

Note

❒ To select all print jobs, press [Se-
lect All Jobs].

❒ If you set the password in step

B, enter the password to print.

❒ Press [UPrev.] or [TNext.] to
scroll through the list.

❒ To clear a selection, press the
highlighted print job again. To
clear all selections, press [Clear
All].

❒ To view details about a selected
print file, press [Details].

H Press [Print].

The confirmation screen appears.

Note

❒ If you set a password in the print-
er driver, a password confirma-
tion screen appears. Enter the
password.

❒ If multiple files are selected, and
some of these require a pass-
word, the machine prints files
that correspond to the entered
password and files that do not
require a password. If no pass-
word is entered, or is entered in-
correctly, the machine prints
only files that do not require a
password. The number of print
files is displayed on the confir-
mation screen.
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I Press [Yes].

The Stored Print file is printed.

Note

❒ Press [No] to cancel printing.

❒ To stop printing after printing
has started, press [Exit], and
then press [Job Reset]. A Stored
Print file is not deleted even if
[Job Reset] is pressed.

❒ A Stored Print file sent to the
machine is not deleted unless
you delete a file or select [Auto
Delete Stored Print Jobs] (see
p.128 “System”). For details, see
p.97 “Deleting Stored Print
Files”.

Deleting Stored Print Files

A Press the {Printer} key to display
the Printer screen.

B Press [Print Jobs].

A list of print files stored in the ma-
chine appears.

C Press [Stored Print Job List].

A list of Stored Print files stored in
the machine appears.

Note

❒ Depending on the security set-
tings, certain print jobs may not
be displayed.

D Select the file you want to delete
by pressing it.

E Press [Delete].

The delete confirmation screen
will appear.

Note

❒ If multiple print files are select-
ed, and some of these require a
password, the machine deletes
files that correspond to the en-
tered password and files that do
not require a password. If no
password is entered, or is en-
tered incorrectly, the machine
deletes only files that do not re-
quire a password. The number
of files to be deleted is dis-
played on the confirmation
screen.

F Press [Yes] to delete the file.

After the file has been deleted, the
file list screen will return.

Note

❒ If you do not want to delete the
file, press [No].

❒ If you set the password in the
printer driver, enter the pass-
word to delete.
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Printing from List Per User ID

If you select [List Per User ID] from [Ini-
tial Print Job List] in [System] of [Printer
Features] (see p.82 “Selecting the Ini-
tial Print Job List”), you can select
printing files from the list of user IDs.

Printing the Desired Print Job

A On the Printer screen, press [Print
Jobs].

A list of user IDs whose files are
stored in the machine appears.

Reference

To display the Printer screen,
see p.83 “Displaying a Print Job
List”.

B Press the user ID whose file you
want to print.

Note

❒ You cannot select multiple user
IDs at the same time.

❒ Press [UPrev.] or [TNext.] to
scroll through the list.

❒ Press [Clear] to cancel a selec-
tion.

C Press [List Per User ID].

The print job list of the selected
user ID appears.

D Select the desired print jobs.

Note

❒ To cancel a selection, press the
highlighted print job again. To
clear all selections, press [Clear
All].

E Press [Print].

A confirmation screen appears.

F Press [Yes].

The selected files are printed.

Note

❒ Press [No] to cancel printing.

Reference

For details about printing each
type of print job, see the follow-
ing:

• p.86 “Sample Print”

• p.89 “Locked Print”

• p.92 “Hold Print”

• p.95 “Stored Print”

Printing All Print Jobs

A On the Printer screen, press [Print
Jobs].

A list of user IDs whose files are
stored in the machine appears.
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B Press the user ID whose file you
want to print.

Note

❒ You cannot select multiple user
IDs at the same time.

❒ Press [UPrev.] or [TNext.] to
scroll through the list.

❒ Press [Clear] to cancel a selection.

C Press [Print All Jobs].

If the selected user ID has multiple
types of print jobs, the selection
screen of the print job type appears.

D Select the desired print job type,
and then press [Yes].

A confirmation screen appears.

Note

❒ The confirmation screen does
not appear if the selected ID has
only one type of print jobs. Pro-
ceed to step E.

❒ You cannot select a print job
that is not stored under the se-
lected user ID.

❒ If you select Sample Print in-
cluding multiple files without
setting a quantity, 1 page less
than the minimum number of
all settings is applied.

❒ If you select Stored Print, the
number you set on the confir-
mation screen is applied to all
files of the selected print job
type. If you do not set a quanti-
ty, the minimum number is ap-
plied to all files.

❒ If you select Locked Print, enter
the correct password. If there
are multiple passwords, the ma-
chine prints only files that corre-
spond to the entered password. 

❒ If you select Stored Print files,
and some of these require a
password, the machine prints
files that correspond to the en-
tered password and files that do
not require a password. If a
password is not entered, files
that do not require a password
are printed.

E Press [Yes].

The selected files are printed.

Note

❒ Press [No] to cancel printing.

Important

❒ After printing is completed,
Sample Print, Locked Print, and
Hold Print files are deleted.

Reference

For details about printing each
type of print job, see the follow-
ings:

• p.86 “Sample Print”

• p.89 “Locked Print”

• p.92 “Hold Print”

• p.95 “Stored Print”
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Spool Printing

Spool Printing allows print jobs transferred from a computer to be temporarily
stored, and then prints them after they are transferred. This shortens printing
time as it maximizes printer efficiency.

Important

❒ During Spool Printing, the hard disk is accessed and the Data-In indicator
blinks. Turning off the computer or machine during Spool Printing can dam-
age the hard disk. Also, if the computer or machine is turned off during Spool
Printing, spooled jobs will be deleted. Therefore, do not turn the power to the
computer or machine off during Spool Printing.

Limitation

❒ If data is sent to the machine using other protocols besides diprint, lpr, ipp,
and smb, Spool Printing cannot be performed.

❒ Up to a maximum of 150 jobs at once can be spool printed.

Note

❒ Printing the first page with Spool Printing will be slow.

❒ The computer requires less print processing time when large amounts of data
are spooled.

❒ Stored spool jobs can be viewed or deleted using Web Image Monitor.

❖ Setting Spool Printing
Spool Printing can be set using telnet or Web Image Monitor.

• Using Web Image Monitor
See Network Guide or Help for more information.

• Using telnet
Type in “spoolsw spool on” to set Spool Printing.
See Network Guide for more information about telnet.

❖ Viewing a list of spool jobs on the display panel
If Spool Printing is set, a list of spooled jobs can be viewed on the display pan-
el screen.
Press the {Printer} key, and then press [Spooling Job List]. A list of spooled jobs
appears.

• Deleting jobs
Select files to be deleted, and then press [Delete].

Note

❒ If Spool Printing is not set, you cannot select [Spooling Job List].

❖ Viewing/Deleting spool jobs in Web Image Monitor
Start Web Image Monitor and enter the machine's IP address in the address
bar. This displays the top page.
For more information, see Network Guide.
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Form Feed

This section gives instructions for op-
erating the machine when there is no
tray for the selected paper size or
type, or when paper loaded in the
machine has run out.

Limitation

❒ The tray cannot be changed if the
following functions are set for it:

• Staple

• Duplex Print to a tray that does
not support duplex printing

• Cover sheet

• Front and Back cover

• Slip sheet

Note

❒ If form feed is selected for a tray
with the following settings, you
can change the tray by canceling
the settings:

• Staple

• Duplex

❒ If Auto Continue is selected, form
fed paper is printed after a set in-
terval. See p.128 “System”.

If the machine does not have a tray for
the selected paper size or paper type,
or if the selected paper loaded in the
machine has run out, a caution mes-
sage appears.

If this message appears, do one of the
following:

Print Using a Selected Tray

A Select the tray for form feed from
those that appear on the display
panel.

If you want to print after adding
paper to the tray, select the tray af-
ter loading the correct paper.

Note

❒ To load paper in the bypass tray,
see p.13 “Setting Paper on the
Bypass Tray”.

B Press [Continue].

The machine prints using the se-
lected tray.

Note

❒ If a tray with a smaller paper
size is selected, the print job
may be cut short, or other prob-
lems may occur.
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Canceling Form Feed

A Press [Reset].

Delete the stored print jobs, and
then cancel form feed.

B Press [Reset Current Job] or [Reset
All Jobs].

• [Reset Current Job]: cancels the
print job currently being proc-
essed.

• [Reset All Jobs]: cancels all jobs
in the print queue.

• [Resume Printing]: resumes print-
ing jobs.

A confirmation message appears.

C Press [Yes] to cancel the print job.

Note

❒ Press [No] to return to the previ-
ous display.

Important

❒ If the machine is shared by mul-
tiple computers, be careful not
to accidentally cancel someone
else's print job.

❒ Under Windows, If the machine
is connected to the computer us-
ing a parallel cable, sent print
jobs may be canceled if [Reset All
Jobs] is pressed while “Wait-
ing...” is on the display panel.
After the interval set in [I/O Time-
out] in Printer Features has
passed, the next print job can be
sent. A print job sent from a dif-
ferent client computer will not
be canceled in this case.

Note

❒ You cannot stop printing data
that has already been proc-
essed. For this reason, printing
may continue for a few pages
after you press [Job Reset].

❒ A print job containing a large
volume of data may take con-
siderable time to stop.

Reference

For details, see p.103 “Cance-
ling a Print Job”.
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Canceling a Print Job

Windows - Canceling a Print 
Job 

A Double-click the printer icon on
the Windows task tray.

A window appears, showing all
print jobs currently queued for
printing. Check the current status
of the job you want to cancel.

B Select the name of the job you want
to cancel.

C On the [Document] menu, click
[Cancel Printing].

Note

❒ In Windows XP, Windows Server
2003, and Windows NT 4.0, click
[Cancel] on the [Document] menu.

❒ In Windows 95 / 98 / Me / 2000
or Windows NT 4.0, you can
also open the print job queue
window by double-clicking the
machine icon in the [Printers]
machine window (the [Printers
and Faxes] window under Win-
dows XP and Windows Server
2003).

D Press the {Printer} key on the ma-
chine's control panel.

E Press [Job Reset] on the display
panel or the {Clear/Stop} key on
the control panel.

F Press [Reset Current Job] or [Reset
All Jobs].

• [Reset Current Job]: cancels the
print job currently being proc-
essed.

• [Reset All Jobs]: cancels all jobs
in the print queue.

• [Resume Printing]: resumes print-
ing jobs.

A confirmation message appears.
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G Press [Yes] to cancel the print job.

Note

❒ Press [No] to return to the previ-
ous display.

Important

❒ If the machine is shared by mul-
tiple computers, be careful not
to accidentally cancel someone
else's print job.

❒ If the machine is connected to
the computer using a parallel
cable, sent print jobs may be
canceled if [Reset All Jobs] is
pressed while “Waiting...” is on
the display panel. After the in-
terval set in [I/O Timeout] in
Printer Features has passed, the
next print job can be sent. A
print job sent from a different
client computer will not be can-
celed in this case.

Note

❒ You cannot stop printing data
that has already been proc-
essed. For this reason, printing
may continue for a few pages
after you press [Job Reset].

❒ A print job containing a large
volume of data may take con-
siderable time to stop.
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Checking the Error Log

If files could not be stored due to printing errors, identify the cause of the errors
by checking the error log on the control panel.

Limitation

❒ The most recent 30 errors are stored in the error log. If a new error is added
when there are 30 errors already stored, the oldest error is deleted. However,
if the oldest error belongs to one of the following print jobs, it is not deleted.
The error is stored separately until the number of those errors reaches 30. You
can check any of these print jobs for error log information.

• Sample Print

• Locked Print

• Hold Print

• Stored Print

❒ If the main power switch is turned off, the log is deleted.

A Press the {Printer} key to display the Printer screen.

B Press [Error Log].

An error log list appears.

C Press the desired job list.
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D Press [Details].

A detailed error log appears.

Note

❒ Press [UPrev.] or [TNext.] to scroll the error files.

❒ Press [Exit] after checking the log.

❒ Press [Back to List] to return to the error log list.

❒ To print files that appear in the error log, resend them after stored files
have been printed or deleted.
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Covers

Using this function, you can insert cover and back sheets fed from a different
tray to that of the main paper, and print on them.

Reference

For printing methods, see the printer driver Help.

Limitation

❒ To use this function, Collate must be set. Rotating Collate cannot be set.

Note

❒ The cover sheets should be the same size and orientation as the body of the
paper.

❒ If “Auto Tray Select” is set as the paper feed tray for the body paper, the paper
will be delivered from a tray containing paper in the K orientation. There-
fore, if the cover paper is set to the L orientation, the orientation of cover and
body will be different.

❖ Cover sheet
Prints the first page of the document on the sheet for the cover page.

• Print on one side
Prints on one side of the cover sheet only, even when duplex printing is se-
lected.

• Print on both sides
Prints on both sides of the cover sheet when duplex printing is selected.

• Front cover printed on both sides

AEV016S

AEV017S
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• Front cover printed on one side

• Blank

• When printing one side

• When printing both sides

❖ Front and Back cover
Prints the first and last page of the document as the cover and back cover pages.

• Print on one side
Prints on one side of the cover sheets only, even when duplex printing is
selected.

• Back cover page face inside

• Print on both sides
Prints on both sides of the cover sheets when duplex printing is selected.

AEV032S

AEV018S

AEV033S

AEV034S
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• Front cover printed on both sides, back cover page face inside, and the
number of pages is even

• Front cover printed on both sides, back cover page face inside, and the
number of pages is odd

• Front cover printed on one side, back cover page face inside, and the
number of pages is even

• Front cover printed on one side, back cover page face inside, and the
number of pages is odd

• Blank

• When printing one side

AEV036S

AEV037S

AEV038S

1

AGP009S

1

AEV040S
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• When printing both sides

AEV041S
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Slip Sheet

❖ Inserting a slip sheet between each page

• Print

• Blank

❖ Inserting a slip sheet between OHP transparencies

• Print

• Blank

AEV019S

AEU023S

AEV020S

AEU024S
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Note

❒ Collate cannot be set when using slip sheets.

❒ When the duplex printing or cover printing is set, you cannot insert slip
sheets.

❒ The slip sheet should be the same size and orientation as the main paper.

❒ If “Auto Tray Select” has been set as the paper feed tray for the body paper,
the paper will be delivered from a tray containing paper in the K orientation.
Therefore, when the cover paper has been set to the L orientation, the orien-
tation of the output cover paper and body paper will be different.

❒ The same paper feed tray cannot be set for the main paper and slip sheets.
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Chaptering

The specified page is printed on the same side as the first page, like a book. Also,
you can insert chapter slip sheets before specified pages, and select whether or
not to print on the slip sheets.

Reference

For printing methods, see the printer driver Help.

Note

❒ Up to 20 pages can be specified as the front pages of chapters using the printer
driver.

❖ No slip sheets

Note

❒ This function is only valid with duplex printing.

❒ This function can be used together with combine (layout) printing.

❖ Inserting chapter slip sheets

• Print
Prints on the chapter slip sheets. When duplex printing is selected, both
sides of the slip sheets are printed on.

AJO025S

AJO023S



Other Print Operations

114

4

• Print on front side only
Prints on the front side of the chapter slip sheets even if duplex printing is
selected.

• Blank

Note

❒ The slip sheet should be the same size and orientation as the body of the
paper.

❒ If “Auto Tray Select” has been set as the paper feed tray for the body paper,
the paper will be delivered from a tray containing paper in the K orienta-
tion. Therefore, when the cover paper has been set to the L orientation, the
orientation of the output cover paper and body paper will be different.

❒ The same paper feed tray cannot be set for the body of the document and
the slip sheet.

AJO022S

AJO024S
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User Defined Pages

Using this function, you can specify the page numbers for each input tray.

Reference

For printing methods, see the printer driver Help.

Limitation

❒ This function is available with the PCL 6/5e printer driver only.

❒ If [Document Server] is selected under [Job Type:], User Defined Page cannot be
used.

❒ If [User Defined Pages] is selected under [Paper Selection:] on [Paper] tab, [Lay-
out:] cannot be selected.

AEV044S
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Collate

When printing multiple documents such as handouts for meetings, you can sep-
arate sets into order. This function is known as “Collate”. Collate stores data
transmitted from a computer in memory. The following are the three types of
collate:

❖ Collate
Printed output is assembled as sets in sequential order.

❖ Rotating collate
Every other print set is rotated by 90 degrees K.

❖ Shift collate
(The optional finisher is required for this function.)
The finisher shift tray moves backward or forward when a job or set is output,
causing the next to shift, so you can separate them.

Limitation

❒ The optional finisher is required for Shift collate.

❒ Rotating collate is not possible when feeding paper from the bypass tray.

❒ Shift collate is not possible when printing on 81/2 × 51/2L.

❒ If jobs containing pages of various sizes are set, Rotating collate will not work.

❒ Rotating collate and Staple functions cannot be combined.

AEU016S

AEU017S

AEU018S
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Note

❒ You can set Collate in the RPCS printer driver.

• If you cannot make Shift collate even with the optional finisher installed,
options may not be set up correctly in the printer driver. Correct the printer
driver's option settings. For details, see the printer driver Help.

❒ If Auto Continue occurs on the first set, Collate will be canceled.

❒ If forced printing occurs on the first set, Collate will be canceled.

❒ If a document with mixed paper sizes or sizes larger than A4, 81/2 × 11 is set,
it can only be collated, even if Rotating collate has been selected.

❒ If the following functions are selected, Collate or Shift collate will be applied
even if Rotating collate is selected:

• Covers

• Slip sheet

❒ When Rotating collate has been selected, printing speed will be slower than
with other collate functions.

❒ When setting Collate in the printer driver settings, make sure that a collate
option is not selected in the application's print settings. If a collate option is
selected, printing will not be as intended.

❒ The Rotating collate function requires two paper trays containing same size
paper but in different orientations.

Reference

For information about paper sizes and the number of sets you can use Collate,
Rotating collate, and Shift collate with in every option, see Copy Reference.

For printing methods, see the printer driver Help.
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Printing with the Finisher

You can collate or staple by installing the optional finisher. Make sure you read
the following precautions when using the optional finisher:

Reference

For information about optional finishers, see General Settings Guide.

To use the staple function, see p.119 “Staple”.

❖ Be sure to make settings for options installed on the machine in the printer drivers.

Reference

To make settings for options in the printer drivers, see p.56 “Making Op-
tion Settings for the Printer”.

❖ Be sure to set the paper size and paper orientation in the printer driver when using
duplex printing, combine (layout), and staple functions.

Reference

For details about duplex printing and layout, see the printer driver Help.

To use the staple function, see p.119 “Staple” and the printer driver Help.

Note

❒ Depending on the application, print settings may not be enabled and printed
output may not be as expected.

❖ When setting staple or collate in the printer driver, make sure that the Collate check
box is cleared in the application's [Print] dialog box.
If Collate is enabled in the application, printing will not be as intended.
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Staple

With the optional finisher installed, sets can be stapled individually when print-
ing multiple sets.

Staple Position

The specified staple position varies depending on paper size, type, quantity and
feed orientation. The following table shows staple positions:

Reference

• For paper sizes and maximum numbers of sheets available for stapling, see
“Specifications”, General Settings Guide.

• For printing methods, see the printer driver Help.

• The staple position will vary when using the PostScript 3 printer driver.
For more information, see the PostScript 3 printer driver Help.

AGP015S
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Stapling Precautions

Limitation

❒ Stapling can be done only with the optional finisher installed.

❒ Stapling cannot be done when paper is fed from the bypass tray.

❒ You cannot interrupt the current job with a job for another function requiring
stapling or collating.

❒ When printing on letterhead, stapling may not be at the specified position.

Note

❒ When the finisher is installed, and when an output tray that cannot output us-
ing the staple function has been selected, the paper will be output according
to System Settings.

❒ If you cannot make staple settings even with the finisher installed, options
may not be set correctly in the printer driver. Correct option settings in the
printer driver. For details, see the printer driver Help.

❒ When duplex printing is selected, adjust staple positions to the binding orien-
tation.

❒ When the finisher is being used for another function's job (for example, a copy
job), printing will start after that job ends.

❒ When setting Staple in the printer driver settings, make sure that a collate op-
tion is not selected in the print settings of the application. If a collate option is
selected in the application, printing will not be as intended.

❒ Be sure to set paper size and orientation in the printer driver when stapling.

• Depending on the software you are using, print settings may not be saved
and the printed result may not be as expected.

❒ When printing restarts after removing jammed paper, the printing position
may be different, depending on the location of the jam.

• If the paper jam occurred in the optional finisher, printing will restart from
the top page of the data currently being printed, or from the page where
the paper jam occurred.

• If the paper jam occurred in the machine, printing will restart from the
page where the paper jam occurred.

❒ Even if the paper jam occurred in the machine, the error will not be cleared
unless the cover of the finisher is opened and closed.
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❒ Staple printing will be canceled under the following conditions:

• If the number of staple jobs exceeds maximum. For information about the
maximum number, see “Specifications”, General Settings Guide.

• If a paper size that cannot be stapled is selected. For information about pa-
per sizes that can be stapled, see “Specifications”, General Settings Guide.

• If positions other than those fixed for stapling are specified.

• If there are inconsistencies between the orientation in the duplex mode and
the staple position.

• If paper sizes are mixed when a different paper size is specified during a
print job.

• When staples have run out.

• When feeding paper from the bypass tray.

• When staples have run out and Auto Continue is set, printing will continue
without stapling after the message has been displayed.

❒ When using the optional Finisher 500 unit, following paper sizes can be sta-
pled using the Mixed Size mode *1 :

• A3 L and A4 K

• B4 L and B5 K

• 11 × 17 L and 8 1/2 × 11 K
*1 This function is not available when using the optional Finisher 1000 unit.
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5. Printer Features

Reference

For more information about copier features and system settings, see Copy Ref-
erence and General Settings Guide.

Printer Features Menu

There are seven menu items in the Printer Features menu:

• List / Test Print

• Maintenance

• System

• Host Interface

• PCL Menu

• PS Menu (optional)

• PDF Menu (optional)

You can select the functions in the following table:

Menu Default

List / Test Print

See p.126 “List / Test 
Print”.

Multiple Lists

Config. Page

Error Log

Menu List

PCL Config. / Font Page

PS Config. / Font Page *1 

PDF Config. / Font Page *1 

Hex Dump

Maintenance

See p.128 “Maintenance”.

Menu Protect

List / Test Print Lock

Delete All Temporary Print Jobs

Delete All Stored Print Jobs

System

See p.128 “System”.

Print Error Report

Auto Continue

Memory Overflow

Job Separation  *2 

Auto Delete Temporary Print Jobs

Auto Delete Stored Print Jobs

Initial Print Job List
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*1 Appears when the PostScript 3 unit (optional) is installed.
*2 Appears when a finisher (optional) is installed.

System

See p.128 “System”.

Memory Usage

Duplex

Copies

Blank Page Print

Edge Smoothing

Toner Saving

Printer Language *1 

Sub Paper Size

Page Size

Letterhead Setting

Bypass Tray Setting Priority

Edge to Edge Print

Default Printer Language *1 

Tray Switching

Host Interface

See p.132 “Host Inter-
face”.

I/O Buffer

I/O Timeout

PCL Menu

See p.132 “PCL Menu”.

Orientation

Form Lines

Font Source

Font Number

Point Size

Font Pitch

Symbol Set

Courier Font

Extend A4 Width

Append CR to LF

Resolution

PS Menu (optional)  *1 

See p.134 “PS Menu”.

Data Format

Resolution

PDF Menu (optional)  *1 

See p.134 “PDF Menu”.

Change PDF Password

PDF Group Password

Resolution

Menu Default
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Adjusting Printer Features

Printer Features allows basic adjustment of operations when using the machine
as a printer.

Although factory default settings are suitable for most printing jobs, Printer Fea-
tures gives you access to a number of settings that control basic printer opera-
tions. Printer Features settings you make are retained even when you turn off
the machine.

For more information about copier features and system settings, see Copy Refer-
ence and General Settings Guide.

A Press the {User Tools/Counter} key on the control panel.

B Press [Printer Features].

C Select the desired item by pressing the tab, and then change its settings.

Note

❒ [OK]: Press to make new settings and go back to previous menus.

❒ [Cancel]: Press to return to a previous menu without changing any setting.

D After changing Printer Features settings, press [Exit] to return to the User
Tools / Counter menu.

Note

❒ You can also exit from the User Tools / Counter menu by pressing the {Us-
er Tools/Counter} key.

❒ Changes made to functions remain in effect even if the machine is turned
off.

❒ You can also exit from the Printer Features menu by pressing [Exit] in the
main menu.
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Printer Features Parameters

List / Test Print

❖ Multiple Lists
You can print the configuration
page and error log.

❖ Config. Page
You can print the machine's cur-
rent configuration values.

Reference

For details, see p.126 “Printing
the configuration page”.

❖ Error Log
You can print error logs listing all
errors that occurred during print-
ing. 

Note

❒ The most recent 30 errors are
stored in the error log. If a new
error is added when there are 30
errors already stored, the oldest
error is deleted. However, if the
oldest error belongs to one of
the following print jobs, it is not
deleted. The error is stored sep-
arately until the number of
those errors reaches 30. You can
check any of these print jobs for
error log information.

• Sample Print

• Locked Print

• Hold Print

• Stored Print

❒ The records of Auto Job Cancel
and jobs canceled manually
from the control panel can be
printed.

❖ Menu List
You can print a Menu List showing
the machine's function menus.

❖ PCL Config. / Font Page
You can print the current configu-
ration and installed PCL font list.

❖ PS Config. / Font Page
You can print the current configura-
tion and installed PostScript font list.

Note

❒ This menu can be selected only
when the optional PostScript 3
unit is installed.

❖ PDF Config. / Font Page
You can print the current configu-
ration and installed PDF font list.

Note

❒ This menu can be selected only
when the optional PostScript 3
unit is installed.

❖ Hex Dump
You can print in the Hex Dump-
mode.

Printing the configuration page

A Press the {User Tools/Counter} key
on the control panel.

The User Tools / Counter menu
appears.

B Press [Printer Features].

The Printer Features menu ap-
pears.

C Press [Config. Page] on the [List /
Test Print] tab.

The configuration page is printed.
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Interpreting the configuration page

❖ System Reference

• Unit Number
Displays the serial number as-
signed to the board by its manu-
facturer.

• Total Memory
Displays the total amount of
memory (SDRAM) installed on
the printer.

• Firmware Version

• Printer
Displays the version number
of the printer firmware.

• System
Displays the version number
of the system firmware.

• Engine
Displays the version number
of the printer engine.

• LCDC
Displays the version number
of the panel display.

• NIB
Displays the version number
of the Network interface.

• Device Connection
This item(s) appears when the
device option(s) is installed.

• HDD: Font / Macro Download
Displays the capacity of the
hard disk drive.

• Printer Language
Displays the version number of
the printer driver language.

• Connection Equipment
Displays the installed optional
equipments.

❖ Paper Input
Displays settings made under Tray
Paper Settings menu.

❖ System
Displays settings made under the
System menu.

Reference

For details, see p.128 “System”.

❖ PCL Menu
Displays settings made under PCL
Menu.

Reference

For details, see p.132 “PCL
Menu”.

❖ PS Menu
Displays settings made under PS
Menu.

Reference

For detai ls ,  see p.134 “PS
Menu”.

❖ PDF Menu
Displays settings made under PDF
Menu.

Reference

For details, see p.134 “PDF
Menu”.

❖ Host Interface
Displays settings made under the
Host Interface menu.
When DHCP is active on the net-
work, the actual IP address, subnet
mask and gateway address appear
in parentheses on the configura-
tion page.

Reference

For details, see p.132 “Host In-
terface”.

❖ Interface Information
Displays the interface information.
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Maintenance

❖ Menu Protect
This procedure lets you protect
menu settings from accidental
change. It makes it impossible to
change menu settings with normal
procedures unless you perform the
required key operations. In a net-
work environment, only adminis-
trators can make changes to menu
settings.

• Level 1
You can protect “Maintenance”,
”System”, “Host Interface”,
“PCL Menu”, “PS Menu” and
“PDF Menu”.

• Level 2
You can protect “Maintenance”,
”System”, “Host Interface”,
“PCL Menu”, “PS Menu”, “PDF
Menu” and “Paper Size” in Sys-
tem Settings.

• Off

Note

❒ Default: Level 2

❒ You can protect menu settings
using a Web Image Monitor.

❖ List / Test Print
You can lock the [List / Test Print]
menu.

• On

• Off

Note

❒ Default: Off

❖ Delete All Temporary Print Jobs
You can delete all print jobs tem-
porarily stored in the machine.

❖ Delete All Stored Print Jobs
You can delete to delete all print
jobs stored in the machine.

System

❖ Print Error Report
Select this to have an error report
printed when a printer or memory
error occurs.

• On

• Off

Note

❒ Default: Off

❖ Auto Continue
You can select this to enable Auto
Continue. When it is On, printing
continues after a system error occurs.

• Off

• Immediate

• 1 minute

• 5 minutes

• 10 minutes

• 15 minutes

Note

❒ Default: Off

❖ Memory Overflow
Select this to have a memory over-
flow error report printed.

• Do not Print

• Error Information

Note

❒ Default: Do not Print

❖ Job Separation
You can enable Job Separation.

• On

• Off

Note

❒ Default: Off

❒ This menu can be selected only
when a finisher (optional) is in-
stalled.
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❖ Auto Delete Temporary Print Jobs
You can select to automatically de-
lete print jobs temporarily stored
in the machine.

• On

• Off

Note

❒ Default: Off

❒ If you select On, you can set up to
200 hours for auto file deleting.

❖ Auto Delete Stored Print Jobs
You can select to automatically de-
lete print jobs stored in the ma-
chine.

• On

• Off

Note

❒ Default: On (3 days)

❒ If you select On, you can set up to
180 days for auto file deleting.

❖ Initial Print Job List
You can set the desired type of
print job list that appears on the
screen when you press [Print Jobs].

• Complete List
Displays the list of print jobs
stored in the machine.

• List Per User ID
Displays the list of the User ID
who stored a file in the machine.

Note

❒ Default: Complete List

❖ Memory Usage
You can select the amount of mem-
ory used in Font Priority or Frame
Priority, according to paper size or
resolution.

• Font Priority
This setting uses memory for
registering fonts.

• Frame Priority
This setting uses frame memory
for high speed printing.

Note

❒ Default: Frame Priority

❖ Duplex
You can select to have print on
both sides of each page.

• Off

• Long Edge Bind

• Short Edge Bind

Note

❒ Default: Off 

❖ Copies
You can specify the number of
print sets. This setting is disabled if
the number of pages to print has
been specified with the printer
driver or another command.

• 1 to 999 by 1

Note

❒ Default: 1
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❖ Blank Page Print
You can select whether or not to
print blank pages.

• On

• Off
Pages that match one of the follow-
ing conditions are identified as
blank.

• There are no images.

• There are images but they are
outside of the printable area.

• There are only blank characters.

Note

❒ Default: On

❒ The printer does not identify
pages with white-coloured im-
ages as blank.

❖ Edge Smoothing
You can set to smoothen the edges
of printed characters.

• On

• Off

Note

❒ Default: On

❒ If you print either photo or half-
tone graphic images, select Off.

❖ Toner Saving
You can save a toner.

• On

• Off

Note

❒ Default: Off

❖ Printer Language
You can specify the printer lan-
guage.

• Auto

• PCL

• PS

• PDF

Note

❒ Default: Auto

❒ This menu appears only when
the PostScript 3 unit (optional)
is installed.

❖ Sub Paper Size
You can enable the Auto Substitute
Paper Size (A4↔LT) feature.

• Auto

• Off

Note

❒ Default: Off

❖ Page Size
You can select the default paper
size.

• 11 × 17

• 81/2 × 14

• 81/2 × 11

• 51/2 × 81/2

• 71/4 × 101/2

• 8 × 13

• 81/2 × 13

• 81/4 × 13

• A3

• B4 JIS

• A4

• B5 JIS

• A5

• A6

• 8 K

• 16 K

• Custom Size
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Note

❒ Default:

• Metric version: A4

• Inch version: 81/2 × 11

❖ Letterhead Setting
You can rotate original images
when printing.
When printing, original images are
always rotated by 180 degrees.
Therefore, output might not be as
expected when printing onto letter-
head or preprinted paper requiring
orientation. Using this function,
you can specify image rotation.

• Off 

• Auto Detect

• On (Always)

Note

❒ Default: Off

❒ When set to Off, original images
are rotated by 180 degrees.

❒ When set to Auto Detect, the ma-
chine detects a letterhead or pre-
printed paper automatically,
and does not rotate them.

❒ When set to On (Always), the
machine does not rotate.

❒ This function reduces printing
speed.

❖ Bypass Tray Setting Priority
You can specify which of the two
options, (Printer) Driver / Com-
mand or Machine Settings, has pri-
ority for determining the paper
size for the bypass tray.

• Driver / Command

• Machine Settings

Note

❒ Default: Driver / Command

❖ Edge to Edge Print
You can select whether or not to
print on the entire sheet.

• Off

• On

Note

❒ Default: Off

❒ The 5 mm margin along the edg-
es may not be printed properly.

❖ Default Printer Language
You can set the default printer lan-
guage if the machine cannot find
the printer language automatical-
ly.

• PCL

• PS

• PDF

Note

❒ Default: PCL

❒ This menu appears only when
the PostScript 3 unit (optional)
is installed.

❖ Tray Switching
You can set to switch the paper
tray.

• Off

• On

Note

❒ Default: Off
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Host Interface

❖ I/O Buffer
You can set the size of the I/O
Buffer. Normally it is not neces-
sary to change this setting.

• 128 KB

• 256 KB

Note

❒ Default: 128 KB 

❖ I/O Timeout
You can set how many seconds the
machine should wait before end-
ing a print job. If data from another
port usually arrives in the middle
of a print job, you should increase
this timeout period.

• 10 seconds

• 15 seconds

• 20 seconds

• 25 seconds

• 60 seconds

Note

❒ Default: 15 seconds

PCL Menu

❖ Orientation
You can set the page orientation.

• Portrait

• Landscape

Note

❒ Default: Portrait

❖ Form Lines
You can set the number of lines per
page.

• 5 to 128 by 1

Note

❒ Default: 

• Metric version: 64

• Inch version: 60

❖ Font Source
You can set the storage location of
the default font.

• Resident

• RAM

• HDD

• SD

Note

❒ Default: Resident

❒ RAM, HDD and SD can be se-
lected only when fonts have
been downloaded to the ma-
chine.

❖ Font Number
You can set the ID of the default
font you want to use.

• 0 to 63 by 1

Note

❒ Default: 0
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❖ Point Size
You can set the point size you want
to use for the selected font.

• 4.00 to 999.75 by 0.25

Note

❒ Default: 12.00

❒ This setting is effective only with
variable-space fonts.

❖ Font Pitch
You can set the number of charac-
ters per inch for the selected font.

• 0.44 to 99.99 by 0.01

Note

❒ Default: 10.00

❒ This setting is effective only
with fixed-space fonts.

❖ Symbol Set
You can specify the set of print
characters for the selected font. The
available options are as follows:
Roman-8, ISO L1, ISO L2, ISO L5,
PC-8, PC-8 D/N, PC-850, PC-852,
PC8-TK, Win L1, Win L2, Win L5,
Desktop, PS Text, VN Intl, VN US,
MS Publ, Math-8, PS Math, VN
Math, Pifont, Legal, ISO 4, ISO 6,
ISO 11, ISO 15, ISO 17, ISO 21, ISO
60, ISO 69, Win 3.0

Note

❒ Default: PC-8 

❖ Courier Font
You can select a courier font type.

• Regular

• Dark

Note

❒ Default: Regular

❖ Extend A4 Width
You can extend the printing area
width (when printing on A4 sheet
with PCL).

• Off

• On

Note

❒ Default: Off

❒ When the setting is On, the
width will be 8 1/2 inches.

❖ Append CR to LF
When set to On, a carriage return
will follow each line feed: CR=CR,
LF=CR−LF, FF=CR−FF.

• Off

• On

Note

❒ Default: Off

❖ Resolution
You can set the print resolution in
dots per inch.

• 300 dpi

• 600 dpi

Note

❒ Default: 600 dpi
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PS Menu

This menu appears only when the op-
tional PostScript 3 unit is installed.

❖ Data Format
You can select a data format.

• Binary Data

• TBCP

Limitation

❒ This setting is not effective when
operating the machine with a
parallel or EtherTalk connection.

❒ When operating the machine
with a parallel connection, and
also if the binary data is sent
from the printer driver, the
print job is canceled.

❒ When operating the machine
with an Ethernet connection,
the print job is canceled under
the following conditions;

• The printer driver data for-
mat is TBCP, and the data
format selected on the dis-
play panel is Binary Data.

• The printer driver data for-
mat is binary, and the data
format selected on the dis-
play panel is TBCP.

Note

❒ Default: TBCP

❖ Resolution
You can set the print resolution in
dots per inch.

• 300 dpi

• 600 dpi

Note

❒ Default: 600 dpi

PDF Menu

This menu appears only when the op-
tional PostScript 3 Unit is installed.

❖ Change PDF Password
Set the password for the PDF file
executing PDF Direct Print.

• Current Password

• New Password

• Confirm New Password
A password can be set using on the
Web Image Monitor, but in this case
the password information is sent
through the network. If security is a
priority, set the password using this
menu from the Control Panel.

Note

❒ Default: Not Set

❖ PDF Group Password
Set the group password already
specified with DeskTopBinder
Lite.

• Current Password

• New Password

• Confirm New Password
A password can be set using on the
Web Image Monitor, but in this case
the password information is sent
through the network. If security is a
priority, set the password using this
menu from the Control Panel.

Note

❒ Default: Not Set

❖ Resolution
You can set the print resolution in
dots per inch.

• 300 dpi

• 600 dpi

Note

❒ Default: 600 dpii



135
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Accessing the Document Server

The Document Server enables you to store documents on the machine's hard
disk, allowing you to edit and print as and when you want.

Limitation

❒ Applications with their own drivers, such as PageMaker, do not support this
function.

Reference

For more information about Document Server functions, see General Settings
Guide.

For information about how to access Document Server from a client, see the
printer driver Help.

Note

❒ When you use the Document Server, the following functions can be selected
using the machine's control panel:

• Copies

• Collate

• Duplex

• Staple

• Paper selection: Paper source tray, paper type, paper output tray.

• Functions related to paper selection: Cover sheet, Slip sheet.

❒ The above items are dimmed, so you cannot set them from the printer prop-
erties dialog box when the Document Server is selected.

❒ You must enter a user ID, using up to eight alphanumeric characters.

❒ You should enter a Password and File Name to distinguish the job from others.

❒ Up to 3,000 files can be stored in the Document Server. No new files can be
stored after 3,000 is reached. Even if less than 3,000 files are stored, new files
cannot be stored when

• a file to be stored contains more than 1,000 pages,

• the total number of pages contained in files stored exceeds 9,000,

• the hard disk is full.

❒ The Document Server also stores files scanned using the Automatic Docu-
ment Feeder (ADF) or exposure glass. You should delete unnecessary stored
files once in a while so as not to exceed the capacity of the hard disk. For how
to delete stored files, see General Settings Guide.

❒ When using the hard disk for functions other than those of Document Server,
you may be unable to store new files in the Document Server, even if there are
less than 3,000 files stored.
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7. The Functions and Settings
of the Machine

Mainframe

Network Guide, PostScript 3 Supplement, and UNIX Supplement cover all mod-
els, and therefore contain all the functions and settings. This chapter describes
the functions and setting items used for configuring the model you are using.

Reference

For details about functions and setting items, see Network Guide, PostScript 3
Supplement and UNIX Supplement.

Functions

The following functions are available with the machine:

• Copy

• Printer

• Scanner

• Fax

• Document Server

Note

❒ The machine must be equipped with the Printer/Scanner Unit in order to use
the printer or scanner function. 

Interface

The following interfaces are available with the machine:

• Ethernet (100BASE-TX / 10BASE-T)

• USB (2.0 / 1.1)

• IEEE 1284 (Parallel)(Optional)

• IEEE 1394 (SCSI print)(Optional)

• IEEE 802.11b (Wireless LAN)(Optional)

• Bluetooth(Optional)

Note

❒ To use the IEEE 1284, IEEE 1394 (SCSI print), IEEE 802.11b (wireless LAN), or
Bluetooth interface, the machine must be equipped with the corresponding
unit for that interface.

❒ You cannot have the IEEE 1284, IEEE 1394 (SCSI print), IEEE 802.11b (wireless
LAN), and Bluetooth interface on the machine at the same time.
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List of the Setting Items

Web Image Monitor

The following are the items of Web Image Monitor available with the machine:

R : Read 

W : Write

 : None

Note

❒ Depending on the security settings, certain items may not be displayed.

Menu Before login After login as 
Admin.

Top Page R R

Reset Printer Job  RW

Reset Device  RW

Status Input Tray R R

Output Tray R R

Toner R R

Function R R

System R R

Counter R R

Printer Language R R

Document Server RW RW

Fax Received File RW 

Job Printer Job History R R

Error Log R R

Print Jobs RW RW

Fax History Transmission R R

Reception R R

LAN-Fax R R

Document Server RW RW

Address Book  RW

Inquiry R R
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Configuration Device Settings System R RW

Paper R RW

Date/Time R RW

Timer R RW

E-mail R RW

Auto E-mail Notifica-
tion

 RW

On-demand E-mail 
Notification

 RW

File Transfer  RW

User Authentication 
Management

 RW

Administrator Au-
thentication Manage-
ment

 RW

Program/Change Ad-
ministrator

 RW

LDAP Server  RW

Printer R RW

Fax General  RW

Administrator Tools  RW

E-mail Settings  RW

IP-Fax Settings  RW

Gateway Settings  RW

Parameter Settings  RW

Interface R RW

Network TCP/IP R RW

NetWare R RW

AppleTalk R RW

SMB R RW

SNMP  RW

SNMPv3  RW

SSDP  RW

Rendezvous R RW

System Log R R

Menu Before login After login as 
Admin.
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telnet

The following telnet can be used with the machine:

access, appletalk, autonet, btconfig, dhcp, diprint, dns, domainname, help, host-
name, ifconfig, info, ipp, netware, passwd, prnlog, rendezvous, route, set, show,
slp, smb, snmp, spoolsw, ssdp, status, syslog, web, wins

Configuration Security Network Security  RW

Access Control  RW

IPP Authentication  RW

SSL/TLS  RW

Certificates  RW

RC Gate Setup RC Gatee  RW

Update RC Gate 
Firmware

 RW

RC Gate Proxy  RW

Webpage RW RW

Menu Before login After login as 
Admin.
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UNIX

The following UNIX commands can be used with the machine:

Device Option Value Function Summary

binding longedge, shortedge, left, top, 
right

Specifies the binding direction for 
duplex printing.

copies Number of copies (1 - 999) Specifies the number of copies.

duplex off, on Specifies whether duplex printing 
is on or off.

filetype pcl, postscript (rps) Specifies the printer language for 
printing.

filter text Specifies the text printing.

mediatype plain, recycled, special, thick, thin, 
color, transparency, letterhead, 
preprinted, prepunched, labels, 
bond, cardstock, thickduplex-
backs, plainorrecycled

Specifies the paper type.

orientation portrait, landscape Specifies the feed direction of the 
paper.

outbin finishershift, finisherproof, inner, 
upper

Specifies the output tray.

paper a3, a4, a5, a6, jisb4, jisb5, ledger, le-
gal, letter, halfletter, executive, fgl, 
foolscap, folio, com10, monarch, 
c6, c5, dl, k8, k16, custom

Specifies the paper size.

qty Number of collated sets (1 - 999) Specifies the number to collate.

resolution value of resolution (200, 300, 600) Specifies the resolution for printing.

staple off, lefttop, righttop, lefttopslant-
port, lefttopslantland, lefttopvert-
port, lefttopvertland, left2port, 
left2land, right2port, right2land, 
righttopvertport, righttopvert-
land, righttopslantport, right-
topslantland, righttophorizport, 
righttophorizland, top2port, 
top2land, lefttophorizport, leftto-
phorizland

Specifies the staple position.

tray tray1, tray2, tray3, tray4, lct, by-
pass, all

Specifies the input tray.
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Settings That Can be Used with PostScript 3

The following PostScript 3 settings can be used with the machine:

Note

❒ Depending on a type of printer drivers, different items may be displayed.

Settings Selectable Items

Collate Off, On

Dithering Auto, User Setting, Text, Photographic

Duplex Off, Open to Left, Open to Top

Fit to Print Size Prompt User, Nearest Size and Scale, Nearest Size and Crop

Image Smoothing Off, On, Auto, Less than 90 ppi, Less than 150 ppi, Less than 
200 ppi, Less than 300 ppi

Input Tray Bypass Tray, Tray 1, Tray 2, Tray 3, Tray 4

Output Tray Destination Internal Tray, Printer Default

Resolution 600 dpi

Size See General Setting Guide.

Staple Off, Top Left, Top Right, 2 at Left, 2 at Right, 2 at Top

Edge Smoothing Off, On

Toner Saving Off, On

Type See General Setting Guide.

Paper Selection Same Paper for All Pages, Different Paper for First Page, Use 
Slip Sheet, Chaptering
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8. Appendix

Software and Utilities Included on the CD-
ROM

Three CD-ROMs come with this printer: “Printer Drivers and Utilities”, “Oper-
ating Instructions”, and “Scanner Driver and Document Management Utility”.
The following are included in the three separate CD-ROMs.

❖ Font Manager 2000
For installing new screen fonts, or organizing and managing fonts already in
the system. For details about Font Manager 2000, see the manual on the CD-
ROM labeled “Printer Drivers and Utilities”.

❖ SmartDeviceMonitor for Admin
For the system administrator to manage network printers.

Reference

See SmartDeviceMonitor for Admin Help.

❖ SmartDeviceMonitor for Client
For users to manage their network print status.

Reference

See SmartDeviceMonitor for Client Help.

❖ 1394 Utility
For the optional IEEE 1394 interface unit. For details, see the Readme file or
the manual provided with the optional IEEE 1394 interface unit.

❖ USB Printing Support 
For connection to Windows 98 SE / Me computers via USB.

❖ Acrobat Reader
This utility allows you to read PDF files (Portable Document Format).

Note

❒ Documentation about using the machine is included on the CD-ROM in
PDF format. For details about using Acrobat Reader, see Acrobat Reader
online Help.

❖ Printer Utility for Mac
This utility allows users to download and manage a variety of fonts as well as
manage printers. For details about this utility, see PostScript Supplement.
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Viewing the contents of the CD-ROM

Follow the procedure below to view the contents of the CD-ROM.

A Insert the CD-ROM into the CD-ROM drive.

The installer starts.

B Click [Browse This CD-ROM].

Explorer starts and displays the contents of the CD-ROM.

Printer Drivers for This Printer

Printing requires installing a printer driver appropriate to your operating system.
The following drivers are included in the supplied CD-ROM with this machine.

*1 Microsoft Windows 95 operating system
*2 Microsoft Windows 98 operating system
*3 Microsoft Windows Millennium Edition
*4 Microsoft Windows 2000 Advanced Server

Microsoft Windows 2000 Server
Microsoft Windows 2000 Professional

*5 Microsoft Windows XP Professional
Microsoft Windows XP Home Edition

*6 Microsoft Windows Server 2003 Standard Edition
Microsoft Windows Server 2003 Enterprise Edition

*7 Microsoft Windows NT Server operating system version 4.0, Microsoft Windows NT
Workstation operating system version 4.0 in a computer using x86 processors.

*8 Versions 8.6 to 9.2 of the Mac OS (Mac OS X Classic mode is supported.)
*9 Mac OS X 10.1 or later (Native mode)
*10 Requires Service Pack 4 or later.
*11 Requires Service Pack 6 or later.
*12 The Adobe PostScript 3 printer drivers and PostScript Printer Description (PPD) files

are included on the CD-ROM labeled “Printer Drivers and Utilities”.
*13 The PostScript Printer Description (PPD) files are included on the CD-ROM labeled

“Printer Drivers and Utilities”.
*14 The Adobe PostScript Printer Description (PPD) installer is included on the CD-

ROM labeled “Printer Drivers and Utilities”.

Printer Language PCL 6 PCL 5e RPCS PostScript 3

Windows 95 *1 OK OK OK OK *12 

Windows 98 *2 OK OK OK OK *12 

Windows Me *3 OK OK OK OK *12 

Windows 2000 *4 OK OK OK OK *13 

Windows XP *5 OK OK OK OK *13 

Windows Server 2003 *6 OK OK OK OK *13 

Windows NT 4.0 *7 OK *11 OK *10 OK *10 OK *11  *12 

Mac OS *8    OK *12 

Mac OS X *9    OK *14 
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❖ PCL printer drivers
Two kinds of PCL printer driver (PCL 5e and PCL 6) are included on the CD-
ROM that comes with this machine. These drivers allow your computer to
communicate with this machine via a printer language.

Note

❒ Some applications may require installation of the PCL 5e printer driver. In
this case, you can install PCL 5e without having to install PCL6.

Reference

See p.17 “Preparing the Machine”.

❖ RPCS printer driver
This printer driver allows the computer to communicate with the printer us-
ing a printer language. In addition to the conventional user interface, another
preset user interface is provided.

Reference

See p.17 “Preparing the Machine”.

❖ Adobe PostScript Printer Drivers and PPD files
Adobe PostScript printer drivers and the PPD files are included on the CD-
ROM provided with this machine. Adobe PostScript printer drivers allow the
computer to communicate with the printer using a printer language. PPD
files allow the printer driver to enable specific printer functions.

Reference

See PostScript 3 Supplement.

❖ PPD files
PPD files are included on the CD-ROM provided with this machine. PPD files
allow the printer driver to enable specific printer functions.

Reference

See PostScript 3 Supplement.
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SmartDeviceMonitor for Admin

SmartDeviceMonitor for Admin is an application that uses TCP/IP and IPX/SPX
to monitor network printers. It can monitor multiple network printers using IP
address. We recommend that network administrators use this application.

❖ File path
SmartDeviceMonitor for Admin is stored in the following folder in the CD-
ROM.

Network\Devmon\Admin\Disk1

❖ Available functions
SmartDeviceMonitor for Admin has the following functions to check:

• printer supplies such as paper or toner;

• results of print jobs executed from the computer.

Reference

For information about the operations of the system administrator, see Net-
work Guide.

For information about using SmartDeviceMonitor for Admin, see Smart-
DeviceMonitor for Admin Help.

Operating system Protocol stack

Windows 95 / 98 / Me TCP/IP provided with Windows 95 / 98 / Me

IPX/SPX provided with Windows 95 / 98 / Me

NetWare Client provided with Windows 95 / 98

Novell Client provided with Windows 95 / 98

Windows 2000 TCP/IP provided with Windows 2000

IPX/SPX provided with Windows 2000

NetWare Client provided with Windows 2000

Novell Client provided with Windows 2000 or Win-
dow NT

Windows XP TCP/IP provided with Windows XP

IPX/SPX provided with Windows XP

NetWare Client provided with Windows XP

Novell Client provided with Windows XP

Windows Server 2003 TCP/IP provided with Windows Server 2003

IPX/SPX provided with Windows Server 2003

NetWare Client provided with Windows Server 2003

Novell Client provided with Windows Server 2003

Windows NT 4.0 TCP/IP provided with Windows NT

IPX/SPX provided with Windows NT

Client Service for NetWare provided with Windows NT

Novell Client provided with Windows 2000 or Win-
dows NT
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SmartDeviceMonitor for Client

SmartDeviceMonitor for Client has the following functions. We recommend that
users install this application.

• Printing in a peer-to-peer network, using TCP/IP or IPP from Windows 95 / 98
/ Me / 2000 / XP, Windows Server 2003, and Windows NT 4.0.

• Constantly monitoring the status of devices on the network using TCP/IP
and IPX/SPX.

❖ File path
SmartDeviceMonitor for Client is stored in the following folder on the CD-
ROM.

Network\Devmon\Client\Disk1

Operating system Protocol stack

Windows 95 / 98 / Me TCP/IP provided with Windows 95 / 98 / Me

IPX/SPX provided with Windows 95 / 98 / Me

NetWare Client provided with Windows 95 / 98 / Me

Novell Client provided with Windows 95 / 98 / Me

Windows 2000 TCP/IP provided with Windows 2000

IPX/SPX provided with Windows 2000

NetWare Client provided with Windows 2000

Novell Client provided with Windows 2000 or NT

Windows XP TCP/IP provided with Windows XP

IPX/SPX provided with Windows XP

NetWare Client provided with Windows XP

Novell Client provided with Windows XP

Windows Server 2003 TCP/IP provided with Windows Server 2003

IPX/SPX provided with Windows Server 2003

NetWare Client provided with Windows Server 2003

Novell Client provided with Windows Server 2003

Windows NT 4.0 TCP/IP provided with Windows NT

IPX/SPX provided with Windows NT

Client Service for NetWare provided with Windows NT

Novell Client provided with Windows 2000 or Win-
dows NT
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❖ Available functions
SmartDeviceMonitor for Client has the following functions.

• Peer-to-peer print function

• Prints directly on the network printer without sending any data to a
print server.

• Prints on a substitute printer when there are too many jobs waiting on
the specified printer, or when an error disables printing (Recovery
Printing).

• Allocates multiple print jobs to multiple printers (Parallel Printing).

• Executes prior group registration of printers specified for Recovery
Printing or Parallel Printing.

• Notification function

• Displays an error message when there is an error on the specified print-
er while transferring or printing data.

• Notifies a print completion. You can also be notified of the print condi-
tion, such as displaying the notice only when Recovery Printing is exe-
cuted.

• Monitoring function

• Checks printer supplies such as paper or toner.

• Simultaneously monitors multiple printers in use.

• Checks the printer's network settings and detailed information of printers.

• Enables you to check the print job log using the user ID.

Limitation

❒ For Recovery Printing or Parallel Printing, the options on the printers must
be the same. If a necessary option is not installed, a printer cannot be used
for Recovery Printing or Parallel Printing.

❒ For Recovery Printing or Parallel Printing, the paper loaded in the printers
must be the same. When a tray is selected for printing, load the same paper
in that tray in all printers.

❒ For Recovery Printing or Parallel Printing, the print results may be differ-
ent if the printers are not the same model or have exactly the same options.

❒ If you select Sample Print, Locked Print, Hold Pint, or Stored Print, you
cannot select Recovery Printing or Parallel Printing.

Reference

See SmartDeviceMonitor for Client Help.
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Troubleshooting

Error & Status Messages on the Display Panel

This section describes the principal messages that appear on the panel display.
If a message not described here appears, act according to the message.

Reference

Before turning the main power off, see “Turning On the Power”, General Set-
tings Guide.

❖ Status messages

❖ Alert messages

Message Status

Hex Dump Mode In the Hex Dump mode, the machine receives data in hexadec-
imal format. Turn off the machine after printing, and then turn 
back on.

Offline The machine is offline. To start printing, switch the machine 
online by pressing [Online] on the display panel.

Please wait. The machine is preparing the development unit. Wait a while.

Printing... The machine is printing. Wait a while.

Ready This is the default ready message. The machine is ready for 
use. No action is required.

Resetting job.... The machine is resetting the print job. Wait until “Ready” ap-
pears on the display panel.

Setting change... The machine is setting changing. Wait a while.

Waiting... The machine is waiting for the next data to print. Wait a while.

Messages/Second messages Causes Solutions

Authentication has failed. The login user name or pass-
word entered is incorrect.

The machine currently cannot 
perform authentication.

Check your login user name 
and password.

Consult an administrator.

Ethernet board has a prob-
lem.

An error has occurred in the 
Ethernet board.

Turn off the main power 
switch, and back on again. If 
the message appears again, 
contact your sales or service 
representative.

HDD has a problem. An error has occurred in the 
hard disk drive.

Turn off the main power 
switch, and back on again. If 
the message appears again, 
contact your sales or service 
representative.



Appendix

150

8

IEEE 802.11b (Wireless LAN) 
has a problem.

IEEE 802.11b interface unit 
was not inserted when the ma-
chine was turned on, or it was 
pulled out after the machine 
turned on.

The settings are not updated 
although the unit is detected, 
or errors are found while ac-
cessing the unit.

Turn off the machine and 
check the IEEE 802.11b inter-
face unit is inserted correctly. 
Then, turn the machine on 
again. If the message appears 
again, call your service center.

Paper in staple tray.Open Fin-
isher Cover and remove paper.

There is paper remaining in-
side the finisher.

Open the cover of the finisher, 
and remove the paper.

Parallel I/F board has a prob-
lem.

An error has occurred in the 
parallel interface board.

Contact your sales or service 
representative.

Printer font error. An error has occurred in the 
font settings.

Check the font settings.

Memory Overflow Maximum capacity of PCL or 
PostScript 3 list display has 
been exceeded.

Reduce the value of [Resolu-

tion:] in the printer driver, or 
select [Frame Priority] from 
[Memory Usage] in [System] 
(see p.128 “System”). If this 
message continues to appear 
after taking these steps, de-
crease the number of files sent 
to the machine.

DToner is almost empty. The toner has almost run out. Replace the toner cartridge 
with a new one.

Turn the main power switch 
off then on.

The IEEE 802.11b interface 
unit may have come off, or an 
error may have occurred in the 
IEEE 802.11b interface unit.

Turn off the main power 
switch, and check the IEEE 
802.11b interface unit is in-
stalled correctly. If the mes-
sage appears again, contact 
your sales or service repre-
sentative.

USB has a problem. An error has occurred in the 
USB interface.

Turn off the main power 
switch, and back on again. If 
the message appears again, 
contact your sales or service 
representative.

Messages/Second messages Causes Solutions
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The Machine Does Not Print

Possible Cause Solutions

Is the power on? Check the cable is securely plugged into the power outlet and the 
machine. Turn on the main power switch.

Is the machine online? If not, press [fOnline] on the display panel.

Does the printer function 
status indicator stay red?

If so, check the error message on the display panel and take re-
quired action.

Is there a warning status or 
error message on the dis-
play panel?

If so, check the error message or warning status on the display 
panel and take the required action.

Does the “Updating the 
destination list...Please 
wait. Specified destina-
tion(s) or sender's name 
has been cleared.” message 
appear?

The destination list is being updated from the network using 
SmartDeviceMonitor for Admin.

Depending on the number of destinations to be updated, there 
may be some delay before you can resume operation. Operations 
are not possible while this message is displayed.

Wait until the message disappears. Do not switch off the power 
while this message is displayed.

Can you print a configura-
tion page?

If you cannot print a configuration page, there maybe a machine 
malfunction. Contact your sales or service representative.

See p.126 “Printing the configuration page” for printing a config-
uration page.

Is the interface cable con-
nected securely to the ma-
chine and computer?

Connect the interface cable securely. If it has a fastener, fasten that 
securely as well.

See p.10 “Connecting the Machine”.

Are you using the correct 
interface cable?

The type of interface cable you should use depends on the compu-
ter. Be sure to use the correct one. If the cable is damaged or worn, 
replace it.

See p.10 “Connecting the Machine”.

Was the interface cable 
connected after the ma-
chine was turned on?

Connect the interface cable before turning on the machine.

Is the signal status satisfac-
tory when using wireless 
LAN in the infrastructure 
mode ?

To check signal status, press {User Tools/Counter} key on the dis-
play panel, and then press [System Settings] on the display panel. 
On the [Interface Settings] tab, select [IEEE 802.11b], and then press 
[Wireless LAN Signal]. If signal quality is poor, move the machine to 
a location where radio waves can pass or remove objects that 
might cause interference.

Note

❒ You can check signal status only when using wireless LAN in 
the infrastructure mode.

When using wireless LAN, 
is the SSID correctly set?

Check using the machine's display panel that the SSID is correctly 
set.

See “Interface Settings/IEEE 802.11b (Option)”, General Settings 
Guide.
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When using wireless LAN, 
is the access point correctly 
set?

Check access point settings when in the infrastructure mode. De-
pending on the access point, client access may be limited by MAC 
address.

Also, check there are no problems in transmission between access 
point and wired clients, and between access point and wireless cli-
ents.

When using wireless LAN, 
is the LED on the wireless 
LAN card lit or blinking?

Confirm the orange LED is lit, and the green LED is lit or blinks 
during transmission.

Is the wireless LAN being 
used in the ad hoc mode?

Turn the main power off and back on. See “Turning On the Pow-
er”, General Settings Guide.

Otherwise, configure [Network] in [Interface Settings] in [System Set-

tings]. See “Setting Up the Machine on a Network”, Network Guide.

Did you change the option 
settings on the machine?

When using the RPCS printer driver on Windows 2000, Windows 
XP, or Windows Server 2003 and connecting with IEEE 1394, an 
error may occur if you change the option settings on the machine. 
In this case, follow the procedure below:

A Unplug the IEEE 1394 interface cables connected to the compu-
ter.

B Run the utility tool for the IEEE 1394 interface board, which is 
stored in the following path on the CD-ROM “Printer Drivers 
and Utilities”.
\UTILITY\1394\

Reference

For more information about using the utility tool for IEEE 
1394, see the README file in the same directory on the CD-
ROM.

C Restart the computer.

D Connect the computer to the machine using the IEEE 1394 in-
terface cables.

Is the weekly timer set? The printer may not be able to print because of the weekly timer 
setting. Check the setting. For details, see “User Tools (System Set-
tings)”, General Settings Guide.

Print cannot be performed 
from the printer driver.

The login user name, password, or driver encryption key entered 
is incorrect.

A high level of encryption was set using the Extended Security 
function.

• Check your login user name, password, and driver encryption 
key.

• For information about the Extended Security settings, consult 
an administrator.

Possible Cause Solutions
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Problem Solutions

Is the Data In indicator 
blinking or lit after starting 
the print job?

If not, data is not being sent to the machine.

❖ When the machine is connected to the computer using 
the interface cable
Check the machine port settings are correct. For parallel port 
connection, port LPT1 or LPT2 should be set.

• Windows 95 / 98 / Me

A Click the [Start] button, point to [Settings], and then click 
[Printers].

B Click the icon of the machine. On the [File] menu, click 
[Properties].

C Click the [Details] tab.

D In the [Print to the following port:] list, confirm the correct 
port is selected.

• Windows 2000 / Windows NT 4.0

A Click the [Start] button, point to [Settings], and then click 
[Printers].

B Click the icon of the machine. On the [File] menu, click 
[Properties].

C Click the [Ports] tab.

D In the [Print to the following port(s)] list, confirm the correct 
port is selected.

• Windows XP

A Click the [Start] button, and then click [Printers and Fax-

es].

B Click the icon of the machine. On the [File] menu, click 
[Properties].

C Click the [Ports] tab.

D In the [Print to the following port(s)] list, confirm the correct 
port is selected.

• Windows Server 2003

A Click the [Start] button, point to [Settings], and then click 
[Printers].

B Click the icon of the machine. On the [File] menu, click 
[Properties].

C Click the [Ports] tab.

D In the [Print to the following port(s)] list, confirm the correct 
port is selected.

❖ Network connection
Contact your network administrator.
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Other Printing Problems

Problem Causes and Solutions

The print on the 
entire page is fad-
ed.

If the [Toner saving] check box is selected in the printer driver settings, the 
entire page will be faded when printed.

For the RPCS printer driver, [Toner saving] is located on the [Print Quality] 
tab. For the PostScript 3 printer driver, see PostScript 3 Supplement.

See the printer driver Help.

Print is smudges. Settings for thick paper have not been made when printing on thick paper 
in the bypass tray.

• PCL 6/5e and PostScript 3
Select [Thick] in the [Type:] list on the [Paper] tab.

• RPCS
Select [Thick] in the [Paper Type:] list on the [Print Settings] tab.

When printing 
graphics, the out-
put and the screen 
are different.

If the printer driver is configured to use the graphics command, the graph-
ics command from the machine is used to print.

If you want to print accurately, set the printer driver to print without using 
the graphics command.

See the printer driver Help.

Page layout is not 
as expected.

Print areas differ depending on machine used. Information that fits on a 
single page on one machine may not fit on a single page of another ma-
chine.

Adjust the [Printable area:] setting in the [Printer Configuration...] dialog box 
on the [Print Settings] tab in the RPCS printer driver.

See the printer driver Help.

Duplex printing is 
malfunctioning.

• Duplex printing cannot be done with paper set in the bypass tray. 
When using duplex printing, make settings to use paper from a tray 
other than the bypass tray.

• Duplex printing cannot be done with thick paper, OHP transparencies, 
or labels specified as the paper type. Specify another paper type.

• Duplex printing cannot be done with a tray for which [1 Sided Copy] has 
been specified as Paper Type on the System Settings menu. Change the 
Paper Type setting for the tray to [2 Sided Copy] on the System Settings 
menu. See General Settings Guide.
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When using Win-
dows 95 / 98 / Me 
/ 2000 / XP, Win-
dows Server 2003, 
or Windows NT 
4.0, combined 
printing does not 
come out as ex-
pected.

Make sure the application's paper size and orientation settings match those 
of the printer driver.

If a different paper size and orientation are set, select the same size and ori-
entation.

When using Win-
dows 95 / 98 / Me 
/ 2000 / XP, Win-
dows Server 2003, 
or Windows NT 
4.0, Auto Re-
duce/Enlarge 
print does not 
come out as ex-
pected.

A print instruc-
tion was issued 
from the compu-
ter, but printing 
did not start.

User Authentication may have been set. Consult the appropriate adminis-
trators.

The print job is not 
canceled even 
when the machine 
is switched to of-
fline status.

Even when the machine is offline, printing is performed when [Job Accept-

ance Priority] has been set in [Parallel Interface] in the [Interface Settings] in the 
System Settings menu. Change the setting of Signal Control to Printer pri-
ority.

See “User Tools (System Settings)”, General Settings Guide.

Photo images are 
coarse.

Some applications reduce print resolution.

Fine dot pattern 
does not print.

Make the following settings with the printer driver:

• Change the [Dithering:] setting on the [Image Adjustments] tab in the 
[Change User Settings...] dialog box on the [Print Quality] tab in the RPCS 
printer driver.

Note

❒ To enable [Change User Settings...], select the [User settings] check box.

See the printer driver Help.

Images are cut off, 
or excess is print-
ed.

You may be using paper smaller than the size selected in the application. 
Use the same size paper as that selected in the application. If you cannot 
load paper of the correct size, use the reduction function to reduce the im-
age, and then print.

See the printer driver Help.

Problem Causes and Solutions
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It takes a long 
time to complete a 
print job.

Photographs and other data intensive pages take a long time for the ma-
chine to process, so simply wait when printing such data.

Changing the following settings with the printer driver may help speed up 
printing:

❖ PCL 5e
Select the lowest value for [Resolution] on the [Print Quality] tab in the 
printer properties dialog box.

❖ PostScript 3
Set the lower value in [Resolution]. The location of this setting is given 
below. 
If your operating system is Windows, select [PostScript (optimize for 

speed)] in [PostScript Output Option]. [PostScript Output Option] is located as 
follows:

• Windows 95 / 98 / Me
[Print Quality] tab in the printer properties dialog box.

• Windows 2000 / XP, Windows 2003 Server
[PostScript Output Option] in [PostScript Options] on [Advanced...] on 
[Layout] tab in the printing preferences dialog box.

• Windows NT 4.0
[File] on [Advanced...] on [Document Defaults] tab in the printing pref-
erences dialog box.

• Mac OS 9.x
[Printer Specifications] in the print dialog box.

• Mac OS X
[Set 3] tab in [Printer Features] in the print dialog box.

If you use Windows, select [PostScript (optimize for speed)]

• Windows 95 / 98 / Me
[PostScript output format:] on the [PostScript] tab in the printer proper-
ties dialog box.

• Windows 2000 / XP, Windows Server 2003
[PostScript Output Option] in [PostScript Option] on [Advanced...] on [Lay-

out] tab in the printing preferences dialog box.

• Windows NT 4.0
[File] on [Document Defaults] on [Advanced...] tab in the printing pref-
erences dialog box.

❖ RPCS
Select the lower value for Resolution on the [Print Quality] tab in the 
printer driver's dialog box.

Note

❒ To enable [Change User Settings...], select the [User settings] check box.
Select [Fast] for [Document type] list on the [Print Quality] tab in the printer 
properties dialog box.

See the printer driver Help.

Problem Causes and Solutions
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It takes a long 
time to complete a 

print job.

The data is so large or complex that it takes time to process. If the Data In 
indicator is blinking, data is being processed. Simply wait until printing 
resumes.

If “Warming Up...” appears on the display panel, the machine is warming 
up. Wait for a while.

It takes too much 
time to resume 
printing.

The data is so large or complex that it takes time to process. If the Data In 
indicator is blinking, data is being processed. Simply wait until printing 
resumes.

The machine was in the Energy Saver mode. To resume from the Energy 
Saver mode, it has to warm up, and this takes time. See General Settings 
Guide.

Paper is not fed 
from the selected 
tray.

When you are using a Windows operating system, printer driver settings 
override those set using the display panel. Set the desired input tray using 
the printer driver.

See the printer driver Help.

Solid lines are 
printed as broken 
lines.

Make the following settings with the printer driver:

• Change the [Dithering:] setting on the [Image Adjustments] tab in the 
[Change User Settings...] dialog box, on the [Print Quality] tab in the RPCS 
printer driver.

See the printer driver Help.

Optional compo-
nents connected to 
the machine are 
not recognized 
when using Win-
dows 95 / 98 / 
Me, Windows 
2000 / XP, Win-
dows Server 2003, 
and Windows NT 
4.0.

You have to configure the option setup in printer properties when bidirec-
tional transmission is not enabled.

See the printer driver Help.

Images are print-
ed in the wrong 
orientation.

The feed orientation you selected and the feed orientation selected in the 
printer driver's option setup might not be the same. Set the machine's feed 
orientation and the printer driver's feed orientation accordingly.

See the printer driver Help.

The printed image 
is different from 
the image on the 
computer's dis-
play.

With certain functions, such as enlargement and reduction, image layout 
might be different to that on the computer display.

You might have selected to replace True Type fonts with machine fonts in 
the printing process.

To print an image similar to that of the computer display, make settings to 
print True Type fonts as an image.

See the printer driver Help.

Problem Causes and Solutions
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Note

❒ If the problem cannot be solved, contact your sales or service representative.

No transmission 
when using 1394 
interface connec-
tion

Check using the following procedure:

A Confirm the IEEE 1394 interface cable is connected securely.

B Restart the computer.
If the error occurs even after executing the above operation, proceed to 
the following steps.

C Unplug the IEEE 1394 interface cable connected to the computer.

D Run the utility tool for the IEEE 1394 interface board, which is stored in 
the following path on the CD-ROM “Printer Drivers and Utilities”:
\UTILITY\1394\

Reference

For more information about using the utility tool for IEEE 1394, see 
the README file in the same directory on the CD-ROM.

E Restart the computer.

When connecting 
the machine using 
USB 2.0, the first 
page of a print job 
that contains a 
large volume of 
data is printed, 
but the remaining 
pages are not.

Check that USB Printing Support is installed on your computer.

Reference

See p.39 “Installing the Printer Driver Using USB”.

Problem Causes and Solutions
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System Settings (Parallel Connection)

❖ Parallel Timing
Specifies the timing for the parallel
interface. Normally, you do not
need to change this setting.

• ACK Inside

• ACK Outside

• STB Down

Note

❒ Default: ACK Outside

❖ Parallel Communication Speed
Specifies the communication
speed of the parallel interface. If
the speed is too high, data may not
be transferred smoothly. If this
happens, change the setting to
“Standard”.

• High Speed

• Standard

Note

❒ Default: High Speed

❖ Selection Signal Status
Specifies the signal level of the par-
allel interface.

• High

• Low

Note

❒ Default: High

❖ Input Prime
Specifies whether the prime signal
is active or inactive when an input
prime signal is sent. Normally, you
do not need to change this setting.

• Effective

• Invalid

Note

❒ Default: Invalid

❖ Bidirectional Communication
Specifies, for instance, how a print-
er connected to the parallel inter-
face responds to a status request. If
you experience problems using an-
other manufacturer’s printer, set
this to Off.

Limitation

❒ If set to Off, asynchronous com-
munication will not work.

• On

• Off

Note

❒ Default: Off

❖ Signal Control
Specifies how to handle any errors
that occur when printing from a
computer. Normally, you do not
need to change this setting.

• Job Acceptance Priority

• Printer Priority

• Facsimile Priority

Note

❒ Default: Job Acceptance Priority
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Precautions when using Windows Server 
2003

Precautions When Using the Terminal Server Mode

Certain printer driver functions are disabled. Disabled functions are displayed
in gray. When using all printer driver functions, use Windows Server 2003 in the
normal mode.
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Specifications

This section contains the machine's electrical and hardware specifications, in-
cluding information about its options.

Component Specifications 

Resolution 600 × 600 dpi

300 × 300 dpi

200 × 200 dpi

Printing speed Type 1:

• 25 ppm

Type 2:

• 30 ppm

(A4K, 81/2 × 11 K plain paper)

Note

❒ Printing speeds depend on the machine. Check which type of 
machine you have. See General Settings Guide.

Interface Standard:

• Ethernet interface (100BASE-TX / 10BASE-T)

• USB 2.0 interface

Option:

• IEEE 1284 parallel interface

Note

❒ Use a standard 36-pin printer cable not longer than 3 meters 
(10 feet).

• IEEE 1394 interface

• IEEE 802.11b wireless LAN interface

• Bluetooth interface

Network protocol TCP/IP, IPX/SPX, AppleTalk

Printer language Standard: PCL 6/5e, RPCS

Option: PostScript 3, PDF

Fonts PCL 6/5e :

Agfa Monotype 35 Intellifonts, 10 TrueType fonts, 13 International 
fonts, and 1 Bitmap font.

PostScript 3 :

136 fonts (Type 2:24, Type 14:112)

Memory 384 MB

Hard disk Storage capacity : 20 GB
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Operating systems sup-
ported by this machine 

Windows 95 / 98 / Me

Windows 2000

Windows XP

Windows Server 2003

Windows NT 4.0

Mac OS 8.6 to 9.2

Mac OS X v10.1 or higher

Network cable 100BASE-TX / 10BASE-T shielded twisted-pair (STP, Catego-
ry/Type5) cable.

Component Specifications 
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Options

Limitation

❒ Only one optional interface board can be installed in the machine at a time.
Therefore, the optional IEEE 1394 interface board, the IEEE 802.11b interface
unit, the IEEE 1284 interface board, and Bluetooth interface unit cannot be in-
stalled concurrently.

IEEE 1394 Interface Board Type B

❖ Transmission spec.:
IEEE 1394

❖ Interface:
IEEE std 1394-1995 compliant
IEEE std 1394a-2000 compliant

❖ Device class:
SCSI print (Windows 2000 / XP, Windows Server 2003)
IP over 1394 (Windows Me / XP, Windows Server 2003)

❖ Protocol:
SBP-2 (SCSI print)
TCP/IP (IP over 1394)

❖ Interface connector:
IEEE 1394 (6 pin × 2)

❖ Required cable:
1394 interface cable (6 pin × 4 pin, 6 pin × 6 pin)

Important

❒ You cannot plug devices together to create loops.

❒ Do not use cable that is more than 4.5 meters in length.

❖ Data transfer speed:
Maximum 400 Mbps

❖ Connectable number of devices on a bus:
Maximum 63

❖ Allowed cable hops on a bus:
Maximum 16

❖ Power supply:
Non external power supply
Cable Power repeated (IEEE 1394a-2000 compliant)
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IEEE 1284 Interface Board Type A

❖ Transmission spec.:
IEEE 1284

❖ Required cableed:
Standard IEEE 1284 compliant Micro Centronics 36 pin cable

IEEE 802.11b Interface Unit Type H

❖ Transmission spec.:
Based on IEEE 802.11b (wireless LAN)

❖ Protocol:
TCP/IP, IPX/SPX, AppleTalk

Note

❒ SmartDeviceMonitor and Web Image Monitor are supported.

❖ Data transfer speed:
Auto select from below speed
1 Mbps, 2 Mbps, 5.5 Mbps, 11 Mbps

❖ Frequency range:

• Inch version:
2412 - 2462 MHz (1 - 11 channels)

• Metric version:
2412 - 2472 MHz (1 - 13 channels)

❖ Transmittable distance:
1 Mbps 400 m *1 

2 Mbps 270 m *1 

5.5 Mbps 200 m *1 

11 Mbps 140 m *1 

*1 These figures are a guideline for outdoor use. In general, the transmittable dis-
tance indoors is 10 - 100 m, depending on environment.

❖ Transmission mode:
Ad hoc, and infrastructure mode

PostScript 3 Unit Type 3030

Reference

See PostScript 3 Supplement.

Bluetooth Interface Unit Type 3245

Reference

See p.52 “Printing with Bluetooth Connection”.
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Bluetooth Interface Unit Type 3245,   164
Bypass tray,   13

C

Canceling a job
Windows,   103

Chaptering,   113
Clear/Stop key,   5
Collate,   116
Configuration page,   126
Connection

Ethernet interface connection,   12
IEEE 1394 interface connection,   11
Parallel interface connection,   11
USB interface connection,   10

Control Panel,   5
printer features,   123

Control panel
hold print,   92
locked print,   89
sample print,   86
stored print,   95

Covers,   107
Custom size paper,   15

printing, bypass tray,   13

D

Data In indicator,   6, 153, 157
Display panel,   5, 6

error messages,   149
Document Server,   135

E

Energy Saver key,   5
Error log,   105
Error messages,   149

F

Finisher,   118
Font Manager 2000,   59
Fonts,   161
Function keys,   6
Function status indicator,   6

H

Hard disk,   161
Hold print,   92

deleting,   94
Host Interface,   132

I

IEEE 1284 Interface Board Type A,   164
IEEE 1394 Interface Board Type B,   163
IEEE 802.11b Interface Unit Type H,   164
Installing the Printer Driver

Quick Install,   17
Installing the Printer Driver 

Using USB,   39
Interface,   161

L

List per user ID
printing,   98

List / Test Print,   126
Locked print,   89

deleting,   91

M

Main power indicator,   5
Maintenance,   128
Memory,   161

N

Network Cable,   162
Network protocol,   161
Number keys,   5

O

OHP Transparencies
printing, bypass tray,   16

On indicator,   5
Operating system,   162
Operation switch,   5
Options,   163
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P

PageMaker,   60
PCL menu,   132
PDF Direct Print,   77
PostScript 3 Unit Type 3030,   164
Precautions when using the Terminal 

Server mode
Windows Server 2003,   160

Precautions when using 
Windows Server 2003

Windows Server 2003,   160
printer driver,   144
Printer features

adjusting,   125
menu,   123
parameters,   126

Printer Language,   161
Printing a PDF File Directly

PDF Direct Print,   77
Printing Method

PDF Direct Print,   77
Printing speed,   161
Printing with Bluetooth Connection

Windows,   52
Printing with Parallel Connection

Windows 2000,   45

R

Resolution,   161

S

Sample print,   86
deleting,   88

Slip sheet,   111
SmartDeviceMonitor for Admin,   146
SmartDeviceMonitor for Client,   147
Specifications,   161
Spool printing,   100
Staple,   119
Stored print,   95

deleting,   97
System,   128

T

Thick Paper
printing, bypass tray,   16

Troubleshooting,   149
error messages,   149
machine does not print,   151
other printing problems,   154
status messages,   149

U

Unauthorized copy control,   78
data security for copying,   78
mask type,   80

User Tools/Counter key,   5

W

Windows
canceling a job,   103

Windows 2000
printer properties, PCL,   62
printer properties, RPCS,   70

Windows 95/98/Me
printer properties, PCL,   61
printer properties, RPCS,   68

Windows NT 4.0
document defaults, PCL,   66
document defaults, RPCS,   75
printer properties, PCL,   66
printer properties, RPCS,   74

Windows Server 2003
printer properties, PCL,   64
printer properties, RPCS,   72

Windows XP
printer properties, PCL,   64

printer properties, RPCS,   72



Declaration of Conformity

“The Product complies with the requirements of the EMC Directive 89/336/EEC and its amending di-

rectives and the Low Voltage Directive 73/23/EEC and its amending directives.”

Caution:

Network interface cables with ferrite core must be used for RF interference suppression.

Copyright © 2005
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